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Conventions used in this guide
TIP: Tips provide helpful hints or shortcuts.

NOTE: Notes provide important information to explain a concept or to complete a task.

CAUTION: Cautions indicate procedures that you should follow to avoid losing data or damaging the
product.

WARNING! Warnings alert you to specific procedures that you should follow to avoid personal injury,
catastrophic loss of data, or extensive damage to the product.
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Product comparison
HP LaserJet Pro CP1520 color printer series

● Prints up to 12 pages per minute (ppm) on A4-size paper in monochrome (black and white), and
8 ppm in color

● Single-sheet priority feed slot (Tray 1) and 150-sheet cassette (Tray 2)

● Hi-Speed universal serial bus (USB) 2.0 port

● Built-in networking to connect to 10Base-T/100Base-TX networks

The product is available in the following configurations.

HP Color LaserJet CP1525n CE874A HP Color LaserJet CP1525nw CE875A

● Prints up to 12 pages per minute (ppm) on A4-size paper
in monochrome (black and white), and 8 ppm in color

● Single-sheet priority feed slot (Tray 1) and 150-sheet
cassette (Tray 2)

● Hi-Speed universal serial bus (USB) 2.0 port

● Built-in networking to connect to 10Base-T/100Base-TX
networks

● 64-megabyte (MB) random-access memory (RAM)
expandable to 320-megabyte.

HP Color LaserJet CP1525n, plus:

● 802.11b/g/n wireless support capability
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Environmental features
Manual duplex printing Save paper by using the manual duplex printing option.

Print multiple pages per sheet Save paper by printing two or more pages of a document side-by-side on one sheet of paper.
Access this feature through the printer driver.

Recycling Reduce waste by using recycled paper.

Recycle print cartridges by using the HP return process.

Energy savings Instant on Fusing technology and sleep mode enable this product to quickly go into reduced
power states when not printing, thus saving energy.

Accessibility features
The product includes several features that aid users with accessibility issues.

● Online user guide that is compatible with text screen-readers.

● Print cartridges can be installed and removed by using one hand.

● All doors and covers can be opened by using one hand.
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Product views

Front view

1

2

3

4

5

6

7

1 Output bin (holds 125 sheets of standard paper)

2 Dual inline memory module (DIMM) door (for adding more memory)

3 Control panel

4 Wireless button and light (wireless model only)

5 Tray 1 -- single-sheet priority feed slot and jam-access door

6 Tray 2 -- 150 sheet cassette

7 Front door (provides access to the print cartridges)
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Back view

1

2

3
4

1 Hi-Speed USB 2.0 port and network port

2 Rear door (for jam access)

3 Power switch

4 Power connection

Interface connections

1

2

1 Network port (top)

2 USB port (bottom)
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Serial number and model number location
The serial number and product model number label is on the inside of the front door.

HEW
LETT-PACKARD

11311 CHINDEN BLVD.

BOISE, IDAHO  83714

USA
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plies with Part 15 of the FCC
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ay cause undesirable operation.
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é

Product No. Q3948M
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Control panel layout

1 2

3

5

6

7

4

1 Ready light (green): The Ready light is on when the product is ready to print. It blinks when the product is receiving
print data.

2 Attention light (amber): The Attention light blinks when a print cartridge is empty or the product requires user
attention.

NOTE: The Attention light does not blink if more than one print cartridge is empty.

3 Control panel display: The display provides information about the product. Use the menus on the display to
establish product settings.

4 Right arrow  and Left arrow  buttons: Use these buttons to navigate through the menus or to increase or decrease
a value that appears on the display.

5 OK button: Press the OK button for the following actions:

● Open the control panel menus.

● Open a submenu displayed on the control panel display.

● Select a menu item.

● Clear some errors.

● Begin a print job in response to a control panel prompt (for example, when the message [OK] to print appears
on the control panel display).

6 Cancel X button: Press this button to cancel a print job whenever the attention light is blinking or to exit the control
panel menus.

7 Back arrow  button: Press this button for the following actions:

● Exit the control panel menus.

● Scroll back to a previous menu in a submenu list.

● Scroll back to a previous menu item in a submenu list (without saving changes to the menu item).
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2 Control panel menus

● Reports menu

● Quick Forms menu

● System Setup menu

● Service menu

● Network Setup menu
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Reports menu
Use the Reports menu to print reports that provide information about the product.

Menu item Description

Demo page Prints a color page that demonstrates print quality.

Menu structure Prints a map of the control panel-menu layout. The active settings for each menu
are listed.

Config report Prints a list of all the product settings. Includes network information when the product
is connected to a network.

Supplies status Prints the status for each print cartridge, including the following information: 

● Estimated percentage of cartridge life remaining

● Approximate pages remaining

● Part numbers for HP print cartridges

● Number of pages printed

● Information about ordering new HP print cartridges and recycling used HP print
cartridges

Network Summary Prints a list of all product network settings

Usage page Prints a page that lists PCL pages, PCL 6 pages, PS pages, pages that were jammed
or mispicked in the product, monochrome (black and white) or color pages; and
reports the page count

HP Color LaserJet CP1525nw only: prints a page that lists the information above,
and the monochrome (black and white) or color pages printed, number of memory
cards inserted, number of PictBridge connections, and the PictBridge page count

PCL font list Prints a list of all the PCL fonts that are installed.

PS font list Prints a list of all the PostScript (PS) fonts that are installed

PCL6 font list Prints a list of all the PCL6 fonts that are installed

Color usage log Prints a report that shows the user name, application name, and color usage
information on a job-by-job basis

Service page Prints the service report

Diagnostics page Prints the calibration and color diagnostics pages

Print Quality Prints a color test page which can be useful for diagnosing print quality defects.
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Quick Forms menu
Menu item Sub-menu item Description

Notebook Paper Narrow Rule

Wide Rule

Child Rule

Prints pages that have preprinted lines

Graph Paper 1/8 inch

5 mm

Prints pages that have preprinted graph lines

Checklist 1-Column

2-Column

Prints pages that have preprinted lines with check boxes

Music Paper Portrait

Landscape

Prints pages that have preprinted lines for writing music
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System Setup menu
In the following table, items that have asterisks (*) indicate the factory default setting.

Menu item Sub-menu item Sub-menu item Description

Language   Select the language for the control panel
display messages and the product
reports.

Paper Setup Def. paper size Letter

A4

Legal

Select the size for printing internal
reports or any print job that does not
specify a size.

 Def. paper type A list of available paper
types appears.

Select the paper type for printing internal
reports or any print job that does not
specify a type.

 Tray 2 Paper type

Paper size

Select the default size and type for Tray 2
from the list of available sizes and types.

 Paper out action Wait forever*

Cancel

Override

Select how the product should react
when a print job requires a size or type
that is not available or when a specified
tray is empty.

Select the Wait forever option to make
the product wait until you load the correct
paper and press the OK button. This is
the default setting.

Select the Override option to print on a
different size or type after a specified
delay.

Select the Cancel option to automatically
cancel the print job after a specified
delay.

If you select either the Override or
Cancel options, the control panel
prompts you to specify the number of
seconds to delay. Press the Right arrow

 button to increase the time, up to
3600 seconds. Press the Left arrow 
button to decrease the time.

Print quality Calibrate color After power on

Calibrate now

After power on: Select how soon the
product should calibrate after you turn it
on. The default setting is 15 minutes.

Calibrate now: Makes the product
perform a calibration immediately. If a job
is processing, the product calibrates after
the job is complete. If an error message
displays, you must clear the error first.
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Menu item Sub-menu item Sub-menu item Description

PowerSave Time Sleep Delay 15 minutes*

30 Minutes

1 Hour

2 Hours

Off

1 Minute

Sets how long the product remains idle
before it enters PowerSave mode. The
product automatically exits PowerSave
mode when you send a print job or press
a control panel button.

Display contrast Medium*

Darker

Darkest

Lightest

Lighter

 Select the level of contrast for the
display.

At Very Low Black Cartridge Stop

Prompt*

Continue

Set how the product behaves when the
black print cartridge reaches the very low
threshold.

● Stop: The product stops printing
until you replace the print cartridge.

● Prompt: The product stops printing
and prompts you to replace the print
cartridge. You can acknowledge
the prompt and continue printing.

● Continue: The product alerts you
that the print cartridge is very low,
but it continues printing.

 Color Cartridges Stop

Prompt*

Continue

Print Black

Set how the product behaves when the
one of the color print cartridges reaches
the very low threshold.

● Stop: The product stops printing
until you replace the print cartridge.

● Prompt: The product stops printing
and prompts you to replace the print
cartridge. You can acknowledge
the prompt and continue printing.

● Continue: The product alerts you
that the print cartridge is very low,
but it continues printing.

● Print Black: The product alerts you
that the print cartridge is very low,
but it continues printing in black
only. To configure the product to
print in color and use the remaining
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Menu item Sub-menu item Sub-menu item Description

toner in the print cartridge past very
low, follow these steps:

1. On the product control panel,
touch the OK button, and then
touch the System Setup
button.

2. Touch the At Very Low
button, and then touch the
Color Cartridges button.
Touch the Continue button.

When you choose to replace the
very low print cartridge, color
printing resumes automatically.

User-Defined Low Black  Type the percentage of life estimated life
remaining at which the product alerts you
that the print cartridge is low.Cyan  

Magenta  

Yellow  

Courier font Regular

Dark

 Selects a version of the Courier font. The
default is Regular.
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Service menu
Use this menu to restore default settings, clean the product, and activate special modes that affect print
output. Items that have asterisks (*) indicate the factory default setting.

Menu item Sub-menu item Description

Cleaning Page  Use this option to clean the product if you see
toner specks or other marks on the printed
output. The cleaning process removes dust and
excess toner from the paper path.

When you select this item, the product prompts
you to load plain paper in Tray 1 and then press
OK to start the cleaning process. Wait until the
process is complete. Discard the page that
prints.

USB Speed High*

Full

Sets the USB speed to High or Full. For the
product to actually operate at high speed, it must
have high speed enabled and be connected to
an EHCI host controller that is also operating at
high speed. This menu item also does not reflect
the current operating speed of the product.

Less paper curl On

Off*

If printed pages are consistently curled, use this
option to set the product to a mode that reduces
curl.

Archive print On

Off*

If you are printing pages that will be stored for a
long time, use this option to set the product to a
mode that reduces toner smearing and dusting.

Firmware Date  Displays the current firmware datecode.

Restore defaults  Sets all customized copy settings to the factory
default values.
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Network Setup menu
Use this menu to establish network configuration settings.

Menu item Sub-menu item Description

Wireless Menu (wireless products
only)

WPS Setup If your wireless router supports this feature, use this
method to set up the product on a wireless network.
This is the simplest method.

 Run Network Test Tests the wireless network and prints a report with the
results.

 Turn Wireless On/Off Enable or disable the wireless network feature.

TCP IP config
Automatic

Manual

Select Automatic to automatically configure all the
TCP/IP settings.

Select Manual to manually configure the IP address,
subnet mask, and default gateway.

The default setting is Automatic.

Auto Crossover On

Off

This item is used when you are connecting the
product directly to a personal computer using an
Ethernet cable (you might have to set this to On or
Off depending on the computer being used).

The default setting is On.

Network services IPv4

IPv6

This item is used by the network administrator to limit
the network services available on this product.

On

Off

The default setting is On.

Show IP Address No

Yes

No: The product IP address will not appear on the
control panel display.

Yes: The product IP address will appear on the
control panel display.

The default setting is No.

Link Speed Automatic (Default)

10T Full

10T Half

100TX Full

100TX Half

Sets the link speed manually if needed.

After setting the link speed, the product automatically
restarts.

Restore defaults  Press OK to restore the network configuration
settings to the default values.
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3 Software for Windows

● Supported operating systems for Windows

● Supported printer drivers for Windows

● Select the correct printer driver for Windows

● Change print job settings

● Change printer-driver settings for Windows

● Remove software for Windows

● Supported utilities for Windows

● Other Windows components and utilities

● Software for other operating systems
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Supported operating systems for Windows
The product supports the following Windows operating systems:

● Windows XP (32-bit, Service Pack 2)

● Windows Server 2003 (32-bit, Service Pack 3)

● Windows Server 2008 (32-bit and 64-bit)

● Windows Vista (32-bit and 64-bit)

● Windows 7 (32-bit and 64-bit)

Supported printer drivers for Windows
● HP PCL 6 (this is the default printer driver)

● HP Universal Print Driver for Windows Postcript

● HP Universal Print Driver for PCL 5

The printer drivers include online Help that has instructions for common printing tasks and also describes
the buttons, checkboxes, and drop-down lists that are in the printer driver.

NOTE: For more information about the universal print driver (UPD), see www.hp.com/go/upd.

Select the correct printer driver for Windows
Printer drivers provide access to the product features and allow the computer to communicate with the
product (using a printer language). Check the installation notes and readme files on the product CD for
additional software and languages.

HP PCL 6 driver description

● Installs from the Add Printer wizard

● Provided as the default driver

● Recommended for printing in all supported Windows environments

● Provides the overall best speed, print quality, and product-feature support for most users

● Developed to align with the Windows Graphic Device Interface (GDI) for the best speed in Windows
environments

● Might not be fully compatible with third-party and custom software programs that are based on
PCL 5

HP UPD PS driver description

● Available for download from the Web at www.hp.com/support/ljcp1520series

● Recommended for printing with Adobe® software programs or with other highly graphics-intensive
software programs

● Provides support for printing from postscript emulation needs, or for postscript flash font support
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HP UPD PCL 5 driver description

● Available for download from the Web at www.hp.com/support/ljcp1520series

● Compatible with previous PCL versions and older HP LaserJet products

● The best choice for printing from third-party or custom software programs

● Designed for use in corporate Windows environments to provide a single driver for use with multiple
printer models

● Preferred when printing to multiple printer models from a mobile Windows computer

Change print job settings
Tool for changing the settings Method for changing the

settings
Duration of changes Hierarchy of changes

Software program settings On the File menu in the software
program, click Page Setup or a
similar command.

These settings are in effect for
the current print job only.

Settings changed here override
settings changed anywhere else.

Printer Properties in the software
program

The steps vary for each software
program. This procedure is most
common.

1. On the File menu in the
software program, click
Print.

2. Select the product, and then
click Properties or
Preferences.

3. Change the settings on any
of the tabs.

These settings are in effect for
the current session of the
software program.

Settings changed here override
default printer driver settings and
default product settings.

Default printer driver settings 1. Open the list of printers on
your computer, and select
this product.

NOTE: This step varies
for each operating system.

2. Click Printer, and then click
Printing Preferences.

3. Change the settings on any
of the tabs.

These settings remain in effect
until you change them again.

NOTE: This method changes
the default settings for the printer
driver for all software programs.

You can override these settings
by changing settings in the
software program.

Default product settings Change product settings on the
control panel, or in the product
management software that came
with your product.

These settings remain in effect
until you change them again.

You can override these settings
by making changes with any
other tool.
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Change printer-driver settings for Windows
Change the settings for all print jobs until the software program is closed

1. On the File menu in the software program, click Print.

2. Select the driver, and then click Properties or Preferences.

The steps can vary; this procedure is most common.

Change the default settings for all print jobs
1. Windows XP, Windows Server 2003, and Windows Server 2008 (using the default Start menu

view): Click Start, and then click Printers and Faxes.

Windows XP, Windows Server 2003, and Windows Server 2008 (using the Classic Start menu
view): Click Start, click Settings, and then click Printers.

Windows Vista: Click Start, click Control Panel, and then in the category for Hardware and
Sound click Printer.

Windows 7: Click Start, and then click Devices and Printers.

2. Right-click the driver icon, and then select Printing Preferences.

Change the product configuration settings
1. Windows XP, Windows Server 2003, and Windows Server 2008 (using the default Start menu

view): Click Start, and then click Printers and Faxes.

Windows XP, Windows Server 2003, and Windows Server 2008 (using the Classic Start menu
view): Click Start, click Settings, and then click Printers.

Windows Vista: Click Start, click Control Panel, and then in the category for Hardware and
Sound click Printer.

Windows 7: Click Start, and then click Devices and Printers.

2. Right-click the driver icon, and then select Properties or Printer properties.

3. Click the Device Settings tab.
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Remove software for Windows
Windows XP

1. Click Start, and then click Programs.

2. Click HP, and then click the product name.

3. Click Uninstall, and then follow the onscreen instructions to remove the software.

Windows Vista and Windows 7

1. Click Start, and then click All Programs.

2. Click HP, and then click the product name.

3. Click Uninstall, and then follow the onscreen instructions to remove the software.

Supported utilities for Windows
● HP Web Jetadmin

● HP Embedded Web Server (The HP EWS is only accessible when the device is network connected,
not when the device is connected via USB.)

● HP ToolboxFX
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Other Windows components and utilities
● Software installer — automates the printing system installation

● Online Web registration

Software for other operating systems
OS Software

UNIX For HP-UX and Solaris networks, go to www.hp.com/support/net_printing to download the
HP Jetdirect printer installer for UNIX.

Linux For information, go to www.hp.com/go/linuxprinting.
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4 Use the product with Mac

● Software for Mac

● Print with Mac
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Software for Mac
Supported operating systems for Mac

The product supports the following Mac operating systems:

● Mac OS X 10.5, 10.6, and later

NOTE: For Mac OS X 10.5 and later, PPC and Intel® Core™ Processor Macs are supported. For Mac
OS X 10.6, Intel Core Processor Macs are supported.

Supported printer drivers for Mac
The HP LaserJet software installer provides PostScript® Printer Description (PPD) files, and Printer
Dialog Extensions (PDEs) for use with Mac OS X computers. The HP printer PPD and PDE files, in
combination with the built-in Apple PostScript printer drivers, provide full printing functionality and access
to specific HP printer features.

Install software for Mac operating systems

Install software for Mac computers connected directly to the product
This product supports a USB 2.0 connection. Use an A-to-B type USB cable. HP recommends using a
cable that is no longer than 2 m (6.5 ft).

1. Connect the USB cable to the product and the computer.

2. Install the software from the CD.

3. Click HP Installer icon, and follow the onscreen instructions.

4. On the Congratulations screen, click the OK button.

5. Print a page from any program to make sure that the printing software is correctly installed.
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Install software for Mac computers on a wired network (IP)

Obtain the IP address

1. Connect the network cable to the product and to the network.

2. Wait for 60 seconds before continuing. During this time, the network recognizes the product and
assigns an IP address or host name for the product.

3. At the product control panel, press the OK button.

4. Press the right arrow  to highlight the Reports menu, and then press the OK button.

5. Press the right arrow  to highlight the Config report option, and then press the OK button.

6. Find the IP address on the Self Test/Configuration page.

HP Color LaserJet CP4525 Printers
    Embedded Jetdirect Page

Install the software

1. Quit all programs on the computer.

2. Install the software from the CD.

3. Click the HP Installer icon, and follow the onscreen instructions.

4. On the Congratulations screen, click the OK button.

5. Print a page from any program to make sure that the printing software is correctly installed.
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Install software for Mac computers on a wireless network
Before installing the product software, make sure the product is not connected to the network using a
network cable.

If your wireless router does not support Wi-Fi Protected Setup (WPS), obtain the wireless router network
settings from your system administrator, or complete the following tasks:

● Obtain the wireless network name or service set identifier (SSID).

● Determine the security password or encryption key for the wireless network.

Connect the product to a wireless network using WPS

If your wireless router supports Wi-Fi Protected Setup (WPS), this is the simplest way to set up the
product on a wireless network.

1. Press the WPS button on your wireless router.

2. Press and hold the Wireless  button on the product control panel for two seconds. Release the
button when the wireless light starts blinking.

3. Wait up to two minutes while the product establishes a network connection with the wireless router.

NOTE: If this method is not successful, try using the wireless network using USB cable method.

Connect the product to a wireless network using WPS by using the control panel menus

If your wireless router supports Wi-Fi Protected Setup (WPS), this is the simplest way to set up the
product on a wireless network.

1. On the front of the product, press the Wireless button. Look at the control panel display to see if
the Wireless Menu item has opened. If it has not opened, complete these steps:

a. On the control panel, press the OK button, and select the Network Setup menu.

b. Select the Wireless Menu item.

2. Select the Wi-Fi Protected Setup item.

3. Use one of these methods to complete the setup:

● Pushbutton: Select the Pushbutton option and follow the instructions on the control panel.
Establishing the wireless connection can take a few minutes.

● PIN: Select the Generate PIN option. The product generates a unique PIN, which you must
type into the wireless router's setup screen. Establishing the wireless connection can take a
few minutes.

NOTE: If this method is not successful, try using the wireless network using a USB cable method.

Connect the product to a wireless network using a USB cable

If your wireless router does not support WiFi-Protected Setup (WPS), use this method to set up the
product on a wireless network. Using a USB cable to transfer settings makes setting up a wireless
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connection easier. After the setup is complete, you can disconnect the USB cable and use the wireless
connection.

1. Insert the software CD into the computer CD tray.

2. Follow the on-screen instructions. When prompted, select the Connect through a wireless
network option. Connect the USB cable to the product when prompted.

CAUTION: Do not connect the USB cable until the installation program prompts you.

3. When the installation is complete, print a configuration page to make sure that the product has a
SSID name.

4. When installation is complete, disconnect the USB cable.

Remove software from Mac operating systems
You must have administrator rights to remove the software.

1. Open Applications.

2. Select Hewlett Packard.

3. Select HP Uninstaller.

4. Select the product from the list of devices, and then click the Uninstall button.

Change printer-driver settings for Mac

Change the settings for all print jobs
until the software program is closed

Change the default settings for all
print jobs

Change the product configuration
settings

1. On the File menu, click the Print
button.

2. Change the settings that you want
on the various menus.

1. On the File menu, click the Print
button.

2. Change the settings that you want
on the various menus.

3. On the Presets menu, click the
Save As... option and type a name
for the preset.

These settings are saved in the
Presets menu. To use the new settings,
you must select the saved preset option
every time you open a program and print.

Mac OS X 10.5 and 10.6

1. From the Apple menu , click the
System Preferences menu and
then click the Print & Fax icon.

2. Select the product in the left side of
the window.

3. Click the Options & Supplies
button.

4. Click the Driver tab.

5. Configure the installed options.

Software for Mac computers

HP Utility for Mac
Use the HP Utility to set up product features that are not available in the printer driver.

You can use the HP Utility when the product uses a universal serial bus (USB) cable or is connected to
a TCP/IP-based network.
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Open the HP Utility

� From the dock, click HP Utility.

-or-

From Applications, click Hewlett Packard, and then click HP Utility.

HP Utility features

Use the HP Utility software to perform the following tasks:

● Obtain information about supplies status.

● Obtain information about the product, such as the firmware version and the serial number.

● Print a configuration page.

● For products connected to an IP-based network, obtain network information and open the
HP Embedded Web Server.

● Configure the paper type and size for the tray.

● Transfer files and fonts from the computer to the product.

● Update the product firmware.

● Display the color usage page.

Supported utilities for Macintosh
● Embedded Web Server
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Print with Mac
Cancel a print job with Mac

1. If the print job is currently printing, cancel it by pressing the Cancel  button on the product control
panel.

NOTE: Pressing the Cancel  button clears the job that the product is currently processing. If
more than one process is running, pressing the Cancel  button clears the process that currently
appears on the product control panel.

2. You can also cancel a print job from a software program or a print queue.

● Software program: Typically, a dialog box appears briefly on the computer screen, allowing
you to cancel the print job.

● Print queue: Open the print queue by double-clicking the product icon in the dock. Highlight
the print job, and then click Delete.

Change the paper size and type with Mac
1. On the File menu in the software program, click the Print option.

2. In the Copies & Pages menu, click the Page Setup button.

3. Select a size from the Paper Size drop-down list, and then click the OK button.

4. Open the Finishing menu.

5. Select a type from the Media-type drop-down list.

6. Click the Print button.

Create and use printing presets with Mac
Use printing presets to save the current printer driver settings for reuse.

Create a printing preset

1. On the File menu, click the Print option.

2. Select the driver.

3. Select the print settings that you want to save for reuse.

4. In the Presets menu, click the Save As... option, and type a name for the preset.

5. Click the OK button.

Use printing presets

1. On the File menu, click the Print option.

2. Select the driver.

3. In the Presets menu, select the printing preset.

NOTE: To use printer-driver default settings, select the standard option.
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Resize documents or print on a custom paper size with Mac

Mac OS X 10.5 and 10.6

Use one of these methods.

1. On the File menu, click the Print option.

2. Click the Page Setup button.

3. Select the product, and then select the correct settings for the Paper Size and
Orientation options.

1. On the File menu, click the Print option.

2. Open the Paper Handling menu.

3. In the Destination Paper Size area, click the Scale to fit paper size box, and
then select the size from the drop-down list.

Print a cover page with Mac
1. On the File menu, click the Print option.

2. Select the driver.

3. Open the Cover Page menu, and then select where to print the cover page. Click either the Before
Document button or the After Document button.

4. In the Cover Page Type menu, select the message that you want to print on the cover page.

NOTE: To print a blank cover page, select the standard option from the Cover Page Type menu.

Use watermarks with Mac
1. On the File menu, click the Print option.

2. Open the Watermarks menu.

3. From the Mode menu, select the type of watermark to use. Select the Watermark option to print
a semi-transparent message. Select the Overlay option to print a message that is not transparent.

4. From the Pages menu, select whether to print the watermark on all pages or on the first page only.

5. From the Text menu, select one of the standard messages, or select the Custom option and type
a new message in the box.

6. Select options for the remaining settings.
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Print multiple pages on one sheet of paper with Mac

1. On the File menu, click the Print option.

2. Select the driver.

3. Open the Layout menu.

4. From the Pages per Sheet menu, select the number of pages that you want to print on each sheet
(1, 2, 4, 6, 9, or 16).

5. In the Layout Direction area, select the order and placement of the pages on the sheet.

6. From the Borders menu, select the type of border to print around each page on the sheet.

Print on both sides of the page (duplex printing) with Mac

Print on both sides manually

1. Insert enough paper into one of the trays to accommodate the print job.

2. On the File menu, click the Print option.

3. Open the Finishing menu, and click the Manual Duplex tab or open the Manual Duplex menu.

4. Click the Manual Duplex box, and select a binding option.

5. Click the Print button. Follow the instructions in the dialog box that displays on the computer before
replacing the output stack in Tray 1 for printing the second half.

6. Go to the product, and remove any blank paper that is in Tray 2.

7. Insert the printed stack face-up with the bottom edge feeding into the product first in Tray 2. You
must print the second side from Tray 2.

8. If prompted, press the appropriate control panel button to continue.
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Set the color options with Mac
Use the Color Options menu or the Color/Quality Options menu to control how colors are interpreted
and printed from software programs.

1. On the File menu, click the Print option.

2. Select the driver.

3. Open the Color Options menu or the Color/Quality Options menu.

4. Open the Advanced menu, or select the appropriate tab.

5. Adjust the individual settings for text, graphics, and photographs.

Use the Services menu with Mac
If the product is connected to a network, use the Services menu to obtain product and supply-status
information.

1. On the File menu, click the Print option.

2. Open the Services menu.

3. To open the embedded Web server and perform a maintenance task, do the following:

a. Select the Device Maintenance tab.

b. Select a task from the drop-down list.

c. Click the Launch button.

4. To go to various support Web sites for this product, do the following:

a. Select the Services on the Web tab.

b. Select an option from the menu.

c. Click the Go! button.
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5 Connect the product

● Supported operating systems for networks

● Connect with USB

● Connect to a network
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Supported operating systems for networks
The following operating systems support network printing:

● Windows 7 (32-bit)

● Windows Vista (32-bit and 64-bit)

● Windows Server 2008

● Windows XP (32-bit, Service Pack 2)

● Windows Server 2003 (32-bit, Service Pack 3)

● Mac OS X 10.5, 10.6, and higher

NOTE: Most network operating systems support a full software installation.

Printer sharing disclaimer
HP does not support peer-to-peer networking, as the feature is a function of Microsoft operating systems
and not of the HP printer drivers. Go to Microsoft at www.microsoft.com.

Connect with USB
This product supports a USB 2.0 connection. Use an A-to-B type USB cable. HP recommends using a
cable that is no longer than 2 m (6.5 ft).

CAUTION: Do not connect the USB cable until the installation software prompts you to connect it.

CD installation
1. Quit all open programs on the computer.

2. Install the software from the CD, and follow the on-screen instructions.

3. When prompted, select the Directly connect to this computer using a USB cable option, and
then click the Next button.

4. When the software prompts you, connect the USB cable to the product and the computer.

5. At the end of the installation, click the Finish button.

6. On the More Options screen, you can install more software, or click the Finish button.

7. Print a page from any program to make sure that the printing software is correctly installed.
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Connect to a network
Supported network protocols

To connect a networking-equipped product to a network, you need a network that uses one or more of
the following protocols.

● TCP/IP (IPv4 or IPv6)

● Port 9100

● LPR

● DHCP

● AutoIP

● SNMP

● Bonjour

● SLP

● WSD

● NBNS

● LLMNR

Install the product on a wired network

Obtain the IP address
1. Connect the network cable to the product and to the network.

2. Wait for 60 seconds before continuing. During this time, the network recognizes the product and
assigns an IP address or host name for the product.

3. At the product control panel, press the OK button.

4. Press the right arrow  to highlight the Reports menu, and then press the OK button.

5. Press the right arrow  to highlight the Config report option, and then press the OK button.
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6. Find the IP address on the Self Test/Configuration page.

HP Color LaserJet CP4525 Printers
    Embedded Jetdirect Page

Install the software
1. Quit all programs on the computer.

2. Install the software from the CD.

3. Follow the onscreen instructions.

4. When prompted, select the Connect through a wired network option, and then click the Next
button.

5. From the list of available printers, select the printer that has the correct IP address.

6. Click the Finish button.

7. On the More Options screen, you can install more software, or click the Finish button.

8. Print a page from any program to make sure that the printing software is correctly installed.

Connect the product to a wireless network (wireless models only)
Before installing the product software, make sure the product is not connected to the network using a
network cable.

If your wireless router does not support Wi-Fi Protected Setup (WPS), obtain the wireless router network
settings from your system administrator, or complete the following tasks:

● Obtain the wireless network name or service set identifier (SSID).

● Determine the security password or encryption key for the wireless network.
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Connect the product to a wireless network using WPS
If your wireless router supports Wi-Fi Protected Setup (WPS), this is the simplest way to set up the
product on a wireless network.

1. Press the WPS button on your wireless router.

2. Press and hold the Wireless  button on the product control panel for two seconds. Release the
button when the wireless light starts blinking.

3. Wait up to two minutes while the product establishes a network connection with the wireless router.

NOTE: If this method is not successful, try using the wireless network using USB cable method.

Connect the product to a wireless network using WPS by using the control panel
menus

If your wireless router supports Wi-Fi Protected Setup (WPS), this is the simplest way to set up the
product on a wireless network.

1. On the front of the product, press the Wireless button. Look at the control panel display to see if
the Wireless Menu item has opened. If it has not opened, complete these steps:

a. On the control panel, press the OK button, and select the Network Setup menu.

b. Select the Wireless Menu item.

2. Select the Wi-Fi Protected Setup item.

3. Use one of these methods to complete the setup:

● Pushbutton: Select the Pushbutton option and follow the instructions on the control panel.
Establishing the wireless connection can take a few minutes.

● PIN: Select the Generate PIN option. The product generates a unique PIN, which you must
type into the wireless router's setup screen. Establishing the wireless connection can take a
few minutes.

NOTE: If this method is not successful, try using the wireless network using a USB cable method.

Connect the product to a wireless network using a USB cable
If your wireless router does not support WiFi-Protected Setup (WPS), use this method to set up the
product on a wireless network. Using a USB cable to transfer settings makes setting up a wireless
connection easier. After the setup is complete, you can disconnect the USB cable and use the wireless
connection.

1. Insert the software CD into the computer CD tray.

2. Follow the on-screen instructions. When prompted, select the Connect through a wireless
network option. Connect the USB cable to the product when prompted.

CAUTION: Do not connect the USB cable until the installation program prompts you.

3. When the installation is complete, print a configuration page to make sure that the product has a
SSID name.

4. When installation is complete, disconnect the USB cable.
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Install the software for a wireless product currently on the network
If the product already has an IP address on a wireless network and you want to install product software
on a computer, complete the following steps.

1. From the product control panel, print a configuration page to obtain the product IP address.

2. Install the software from the CD.

3. Follow the on-screen instructions.

4. When prompted, select the Connect through a wireless network option, and then click the
Next button.

5. From the list of available printers, select the printer that has the correct IP address.

Disconnect from the wireless network
If you want to disconnect the product from a wireless network, you can turn off the wireless unit in the
product.

1. At the product control panel, press the wireless button.

2. To confirm that the wireless unit is turned off, print a Network Summary page from the Reports
menu, and then verify that it lists the wireless feature as disabled.

Reduce interference on a wireless network
The following tips can reduce interference in a wireless network:

● Keep the wireless devices away from large metal objects, such as filing cabinets, and other
electromagnetic devices, such as microwaves and cordless telephones. These objects can disrupt
radio signals.

● Keep the wireless devices away from large masonry structures and other building structures. These
objects can absorb radio waves and lower signal strength.

● Position the wireless router in a central location in line of sight with the wireless products on the
network.
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Advanced wireless setup

Wireless communication modes

You can use one of two wireless communication modes: infrastructure or ad-hoc.

Infrastructure wireless
network (recommended)

The product communicates with other devices on the network through a wireless router.

Ad-hoc wireless network The product communicates directly with other wireless devices without using a wireless router.

All devices on the ad hoc network must have the following:

● 802.11b/g compatibility

● The same SSID

● The same subnet and channel

● The same 802.11 security settings

Wireless security

To make your wireless network easy to distinguish from other wireless networks, use a unique network
name (SSID) for your wireless router. Your wireless router might have a default network name, which
is typically the manufacturer's name. For information on how to change the network name, see the
documentation that came with the wireless router.
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To prevent other users from accessing your network, turn on WPA or WEP data encryption.

● Wired Equivalent Privacy (WEP): WEP is the original native security mechanism in the 802.11
standard. You create a unique key containing hexadecimal characters, which other users must
provide before they can access your network.

● Wi-Fi Protected Access (WPA): WPA uses the temporal key integrity protocol (TKIP) for encryption
and employs 802.1X authentication. It addresses all known weaknesses of WEP. You create a
unique passphrase containing a combination of letters and numbers, which other users must
provide before they can access your network.

● WPA2 provides the advanced encryption standard (AES), and is an improvement over WPA.

Connect the product to an ad-hoc wireless network

You can connect the product wirelessly to a computer through a peer-to-peer (ad-hoc) installation.

1. Make sure the product is not connected to the network with an Ethernet cable.

2. Turn on the product, and then turn on the wireless functionality.

3. Make sure the product is using the factory default network settings. Open the Service menu, and
then select the Restore defaults option.

4. Turn on the product the wireless functionality again.

5. Print a Network Summary page and find the wireless network name (SSID). Open the Reports
menu, and then select the Network Summary option.

6. Refresh the list of wireless networks on your computer, and then click the product wireless network
name (SSID) and connect to it.

7. After several minutes, print a configuration page, and then find the product IP address.

8. At the computer, insert the product CD, and follow the on-screen instructions to install the software.
When prompted, select the Connect through a wireless network option.

Configure IP network settings
To configure network parameters on the product, use the product control panel, the embedded Web
server, or, for Windows operating systems, the HP ToolboxFX software.

View or change network settings
Use the embedded Web server to view or change IP configuration settings.

1. Print a configuration page, and locate the IP address.

● If you are using IPv4, the IP address contains only digits. It has this format:

xxx.xxx.xxx.xxx

● If you are using IPv6, the IP address is a hexadecimal combination of characters and digits.
It has a format similar to this:
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xxxx::xxxx:xxxx:xxxx:xxxx

2. To open the embedded Web server, type the IP address into the address line of a Web browser.

3. Click the Networking tab to obtain network information. You can change settings as needed.

Set or change the product password
Use the HP Embedded Web Server to set a password or change an existing password for a product on
a network.

1. Type the product IP address into the address line of a Web browser. Click the Networking tab,
and click the Security link.

NOTE: If a password has previously been set, you are prompted to type the password. Type the
password, and then click the Apply button.

2. Type the new password in the New Password box and in the Verify password box.

3. At the bottom of the window, click the Apply button to save the password.

Manually configure IPv4 TCP/IP parameters from the control panel
1. On the control panel, press the Setup button.

2. Use the arrow buttons to select the Network configuration option, and then press the OK button.

3. Use the arrow buttons to select the TCP/IP configuration option, and then press the OK button.

4. Use the arrow buttons to select the Manual option, and then press the OK button.

5. Use the alphanumeric buttons to type the IP address, and then press the OK button.

6. If the IP address is incorrect, use the arrow buttons to select the No option, and then press the
OK button. Repeat step 5 with the correct IP address, and then repeat step 5 for the subnet mask
and default gateway settings.

Link speed and duplex settings 
NOTE: This information applies only to Ethernet networks. It does not apply to wireless networks.

NOTE: Incorrect changes to the link speed setting might prevent the product from communicating with
other network devices. For most situations, the product should be left in automatic mode. Changes can
cause the product to turn off and then on. Changes should be made only while the product is idle.

1. On the control panel, press the Setup option.

2. Use the arrow buttons to select the Network configuration option, and then press the OK button.

3. Use the arrow buttons to select the Link speed option, and then press the OK button.

4. Use the arrow buttons to select one of the following settings.

● Automatic

● 10T Full

● 10T Half
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● 100TX Full

● 100TX Half

NOTE: The setting must match with the network product to which you are connecting (a network
hub, switch, gateway, router, or computer).

5. Press the OK button. The product turns off and then on.
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6 Paper and print media

● Understand paper use

● Change the printer driver to match the paper type and size

● Supported paper sizes

● Supported paper types

● Load paper trays
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Understand paper use
This product supports a variety of paper and other print media in accordance with the guidelines in this
user guide. Paper or print media that does not meet these guidelines might cause poor print quality,
increased jams, and premature wear on the product.

For best results, use only HP-brand paper and print media designed for laser printers or multiuse. Do
not use paper or print media made for inkjet printers. Hewlett-Packard Company cannot recommend
the use of other brands of media because HP cannot control their quality.

It is possible for paper to meet all of the guidelines in this user guide and still not produce satisfactory
results. This might be the result of improper handling, unacceptable temperature and/or humidity levels,
or other variables over which Hewlett-Packard has no control.

CAUTION: Using paper or print media that does not meet Hewlett-Packard's specifications might
cause problems for the product, requiring repair. This repair is not covered by the Hewlett-Packard
warranty or service agreements.

Special paper guidelines
This product supports printing on special media. Use the following guidelines to obtain satisfactory
results. When using special paper or print media, be sure to set the type and size in the printer driver
to obtain the best results.

CAUTION: HP LaserJet products use fusers to bond dry toner particles to the paper in very precise
dots. HP laser paper is designed to withstand this extreme heat. Using inkjet paper could damage the
product.

Media type Do Do not

Envelopes ● Store envelopes flat.

● Use envelopes where the seam
extends all the way to the corner of
the envelope.

● Use peel-off adhesive strips that
are approved for use in laser
printers.

● Do not use envelopes that are
wrinkled, nicked, stuck together, or
otherwise damaged.

● Do not use envelopes that have
clasps, snaps, windows, or coated
linings.

● Do not use self-stick adhesives or
other synthetic materials.

Labels ● Use only labels that have no
exposed backing between them.

● Use labels that lie flat.

● Use only full sheets of labels.

● Do not use labels that have wrinkles
or bubbles, or are damaged.

● Do not print partial sheets of labels.

Transparencies ● Use only transparencies that are
approved for use in color laser
printers.

● Place transparencies on a flat
surface after removing them from
the product.

● Do not use transparent print media
not approved for laser printers.

Letterhead or preprinted forms ● Use only letterhead or forms
approved for use in laser printers.

● Do not use raised or metallic
letterhead.
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Media type Do Do not

Heavy paper ● Use only heavy paper that is
approved for use in laser printers
and meets the weight specifications
for this product.

● Do not use paper that is heavier
than the recommended media
specification for this product unless
it is HP paper that has been
approved for use in this product.

Glossy or coated paper ● Use only glossy or coated paper
that is approved for use in laser
printers.

● Do not use glossy or coated paper
designed for use in inkjet products.

Change the printer driver to match the paper type and
size

NOTE: If you change the page settings in the software program, those settings override any settings
in the printer driver.

1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Paper/Quality tab.

4. Select a size from the Paper size drop-down list.

5. Select a paper type from the Paper type drop-down list.

6. Click the OK button.
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Supported paper sizes
This product supports a number of paper sizes, and it adapts to various paper.

NOTE: To obtain best print results, select the appropriate paper size and type in your print driver before
printing.

Table 6-1  Supported paper and print media sizes

Size Dimensions

Letter 216 x 279 mm (8.5 x 11 inches)

Legal 216 x 356 mm (8.5 x 14 inches)

Executive 184 x 267 mm (7.24 x 10.51 inches)

8.5 x 13 216 x 330 mm (8.5 x 13 inches)

4 x 6 102 x 152 mm (4 x 6 inches)

5 x 8 127 x 203 mm (5 x 8 inches)

A4 210 x 297 mm (8.27 x 11.69 inches)

A5 148 x 210 mm (5.83 x 8.27 inches)

A6 105 x 148 mm (4.13 x 5.83 inches)

B5 (JIS) 182 x 257 mm (7.17 x 10.12 inches)

10 x 15 cm 100 x 150 mm (3.9 x 5.9 inches)

16k 184 x 260 mm (7.24 x 10.23 inches)

195 x 270 mm (7.68 x 10.62 inches)

197 x 273 mm (7.75 x 10.75 inches)

Custom Minimum: 76 x 127 mm (3 x 5 in)

Maximum: 216 x 356 mm (8.5 x 14.0 in)

Table 6-2  Supported envelopes and postcards

Size Dimensions

Japanese Postcard

Postcard (JIS)

100 x 148 mm (3.94 x 5.83 inches)

Double Japan Postcard
Rotated

Double Postcard (JIS)

148 x 200 mm (5.82 x 7.87 inches)

Envelope #10 105 x 241 mm (4.13 x 9.49 inches)

Envelope DL 110 x 220 mm (4.33 x 8.66 inches)

Envelope C5 162 x 229 mm (6.93 x 9.84 inches)

Envelope B5 176 x 250 mm (6.7 x 9.8 inches)

Envelope Monarch 98 x 191 mm (3.9 x 7.5 inches)
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Supported paper types
Paper type Dimensions1 Weight Capacity2 Paper orientation

Paper, including the
following types:

● Plain

● Letterhead

● Color

● Preprinted

● Prepunched

● Recycled

Minimum: 76 x 127 mm
(3 x 5 inches)

Maximum: 216 x 356 mm
(8.5 x 14 inches)

60 to 90 g/m2 (16 to 24 lb) Tray 1: single sheet only

Tray 2: up to 150 sheets of

75 g/m2 (20 lb bond)

Side to be printed on face-
up, with the top edge at
the back of the tray

Thick paper Same as for paper Up to 200 g/m2 (53 lb) Tray 1: single sheet only

Tray 2: up to 15 mm
(0.6 inches) stack height

Side to be printed on face-
up, with the top edge at
the back of the tray

Cover paper Same as for paper Up to 200 g/m2 (53 lb) Tray 1: single sheet only

Tray 2: up to 15 mm (.
59 inch) stack height

Side to be printed on face-
up, with the top edge at
the back of the tray

Glossy paper

Photo paper

Same as for paper Up to 220 g/m2 (59 lb) Tray 1: single sheet only

Tray 2: up to 15 mm (.
59 inch) stack height

Side to be printed on face-
up, with the top edge at
the back of the tray

Transparencies A4 or Letter Thickness: 0.12 to
0.13 mm (4.7 to 5.1 mils)

Tray 1: single sheet only

Tray 2: up to 50 sheets

Side to be printed on face-
up, with the top edge at
the back of the tray

Labels3 A4 or Letter Thickness: up to 0.23 mm
(9 mils)

Tray 1: single sheet only

Tray 2: up to 50 sheets

Side to be printed on face-
up, with the top edge at
the back of the tray

Envelopes ● COM 10

● Monarch

● DL

● C5

● B5

Up to 90 g/m2 (24 lb) Tray 1: single envelope
only

Tray 2: up to 10 envelopes

Side to be printed on face-
up, with the stamp-end at
the back of the tray

Postcards or index cards 100 x 148 mm
(3.9 x 5.8 inches)

 Tray 1: single sheet only

Tray 2: up to 50 sheets

Side to be printed on face-
up, with the top edge at
the back of the tray

1 The product supports a wide range of standard and custom sizes of paper. Check the printer driver for supported sizes.
2 Capacity can vary depending on paper weight and thickness, and environmental conditions.
3 Smoothness: 100 to 250 (Sheffield)
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Load paper trays
Load Tray 1
1. Place a single sheet of paper into the Tray 1

slot, and slide the paper guides so that they are
against the sheet.

 

2. Feed the sheet into the tray as far as it will go
until the product pulls the paper.

NOTE: Wake the product from Powersave
mode before inserting the paper into Tray 1. If
the product is in Powersave mode, it will not pull
the paper when inserted into Tray 1.

 

Load Tray 2
1. Pull the tray out of the product.  
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2. Slide open the paper length and width guides.  

3. To load Legal-size paper, extend the tray by
pressing and holding the extension tab while
pulling the front of the tray outward.

NOTE: When loaded with Legal-size paper,
the tray extends from the front of the product
approximately 51 mm (2 inches).

 

4. Place the paper in the tray and make sure that
it is flat at all four corners. Slide the paper length
and width guides so that they are against the
stack of paper.
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5. Push down on the paper to make sure that the
paper stack is below the paper limit tabs on the
side of the tray.

 

6. Slide the tray into the product.  

50 Chapter 6   Paper and print media ENWW



Configure trays
By default, the product pulls paper from Tray 1. If Tray 1 is empty, the product pulls paper from Tray 2.
Configuring the tray on this product changes the heat and speed settings to obtain the best print quality
for the type of paper that you are using. If you are using special paper for all or most print jobs on the
product, change this default setting on the product.

The following table lists possible ways you can use the tray settings to meet your printing needs.

Paper use Configure the product Print

Load both trays with the same paper, and
have the product pick paper from one
tray if the other one is empty.

Load paper in Tray 1. No configuration is
needed, if the default settings for type
and size have not been changed.

From the software program, print the job.

Occasionally use special paper, such as
heavy paper or letterhead, from a tray
that usually contains plain paper.

Load special paper in Tray 1. From the software program print dialog,
chose the paper type that matches the
special paper loaded in the tray before
sending the print job.

Frequently use special paper, such as
heavy paper or letterhead, from one tray.

Load special paper in Tray 1, and
configure the tray for the paper type.

From the software program print dialog,
chose the paper type that matches the
special paper loaded in the tray before
sending the print job.

Configure trays from the control panel

1. Make sure the product is turned on.

2. Perform one of the following tasks:

● Control panel: Open the System Setup menu, and open the Paper Setup menu. Select the
tray that you want to configure.

● Embedded Web server: Click the Settings tab, and then click Paper Handling in the left
panel.

3. Change the desired tray setting, and then press OK or click Apply.
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7 Print tasks

● Cancel a print job

● Basic print tasks with Windows

● Additional print tasks with Windows
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Cancel a print job
1. If the print job is currently printing, cancel it by pressing the Cancel  button on the product control

panel.

NOTE: Pressing the Cancel  button clears the job that the product is currently processing. If
more than one process is running, pressing the Cancel  button clears the process that currently
appears on the product control panel.

2. You can also cancel a print job from a software program or a print queue.

● Software program: Typically, a dialog box appears briefly on the computer screen, allowing
you to cancel the print job.

● Print queue: If a print job is waiting in a print queue (computer memory) or print spooler,
delete the job there.

◦ Windows XP, Server 2003, or Server 2008: Click Start, click Settings, and then click
Printers and Faxes. Double-click the product icon to open the window, right-click the
print job that you want to cancel, and then click Cancel.

◦ Windows Vista: Click Start, click Control Panel, and then, under Hardware and
Sound, click Printer. Double-click the product icon to open the window, right-click the
print job that you want to cancel, and then click Cancel.

◦ Windows 7: Click Start, and then click Devices and Printers. Double-click the product
icon to open the window, right-click the print job that you want to cancel, and then click
Cancel.
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Basic print tasks with Windows
The methods to open the print dialog from software programs can vary. The procedures that follow
include a typical method. Some software programs do not have a File menu. See the documentation
for your software program to learn how to open the print dialog.

Open the printer driver with Windows
1. On the File menu in the software program, click

Print.
 

2. Select the product, and then click the
Properties or Preferences button.

 

Get help for any printing option with Windows
1. Click the Help button to open the online Help.  
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Change the number of print copies with Windows
1. On the File menu in the software program, click Print.

2. Select the product, and then select the number of copies.

Save custom print settings for reuse with Windows

Use a printing shortcut with Windows

1. On the File menu in the software program, click
Print.

 

2. Select the product, and then click the
Properties or Preferences button.
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3. Click the Printing Shortcuts tab.  

4. Select one of the shortcuts, and then click the
OK button.

NOTE: When you select a shortcut, the
corresponding settings change on the other
tabs in the printer driver.

 

Create printing shortcuts

1. On the File menu in the software program, click
Print.
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2. Select the product, and then click the
Properties or Preferences button.

 

3. Click the Printing Shortcuts tab.  

4. Select an existing shortcut as a base.

NOTE: Always select a shortcut before
adjusting any of the settings on the right side of
the screen. If you adjust the settings and then
select a shortcut, or if you select a different
shortcut, all your adjustments are lost.
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5. Select the print options for the new shortcut.

NOTE: You can select the print options on
this tab or on any other tab in the printer driver.
After selecting options on other tabs, return to
the Printing Shortcuts tab before continuing
with the next step.

 

6. Click the Save As button.  

7. Type a name for the shortcut, and click the
OK button.

 

Improve print quality with Windows

Select the page size with Windows
1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.
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3. Click the Paper/Quality tab.

4. Select a size from the Paper size drop-down list.

Select a custom page size with Windows
1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Paper/Quality tab.

4. Click the Custom button.

5. Type a name for the custom size and specify the dimensions.

● The width is the short edge of the paper.

● The length is the long edge of the paper.

NOTE: Always load paper into the trays short edge first.

6. Click the OK button, and then click the OK button on the Paper/Quality tab. The custom page size
will appear in the list of paper sizes the next time you open the printer driver.

Select the paper type with Windows
1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Paper/Quality tab.

4. From the Paper type drop-down list, click the More... option.

5. Expand the list of Type is: options.

6. Expand the category of paper types that best describes your paper, and then click the paper type
that you are using.

Select the paper tray with Windows
1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Paper/Quality tab.

4. Select a tray from the Paper source drop-down list.
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Print on both sides (duplex) with Windows
1. On the File menu in the software program, click

Print.
 

2. Select the product, and then click the
Properties or Preferences button.

 

3. Click the Finishing tab.  
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4. Select the Print on both sides (manually)
check box. Click the OK button to print the first
side of the job.

 

5. Retrieve the printed stack from the output bin,
and maintaining the same orientation, place it
with the printed side facing down in Tray 2.

 

6. On the control panel, press the OK button to
print the second side of the job.
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Print multiple pages per sheet with Windows
1. On the File menu in the software program, click

Print.
 

2. Select the product, and then click the
Properties or Preferences button.

 

3. Click the Finishing tab.  
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4. Select the number of pages per sheet from the
Pages per sheet drop-down list.

 

5. Select the correct Print page borders, Page
order, and Orientation options.

 

Select page orientation with Windows
1. On the File menu in the software program, click

Print.
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2. Select the product, and then click the
Properties or Preferences button.

 

3. Click the Finishing tab.  

4. In the Orientation area, select the Portrait or
Landscape option.

To print the page image upside down, select
the Rotate by 180 degrees option.
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Set color options with Windows
1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Color tab.

4. Click the HP EasyColor check box to clear it.

5. In the Color Options area, click the Manual option, and then click the Settings button.

6. Adjust the general settings for Edge Control, and settings for text, graphics, and photographs.
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Additional print tasks with Windows
Print colored text as black (grayscale) with Windows

1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Advanced tab.

4. Expand the Document Options section.

5. Expand the Printer Features section.

6. In the Print All Text as Black drop-down list, select the Enabled option.

Print on preprinted letterhead or forms with Windows
1. On the File menu in the software program, click

Print.
 

2. Select the product, and then click the
Properties or Preferences button.
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3. Click the Paper/Quality tab.  

4. From the Paper type drop-down list, click the
More... option.

 

5. Expand the list of Type is: options.  
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6. Expand the list of Other options.  

7. Select the option for the type of paper you are
using, and click the OK button.

 

Print on special paper, labels, or transparencies
1. On the File menu in the software program, click

Print.
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2. Select the product, and then click the
Properties or Preferences button.

 

3. Click the Paper/Quality tab.  

4. From the Paper type drop-down list, click the
More... option.
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5. Expand the list of Type is: options.  

6. Expand the category of paper types that best
describes your paper.

NOTE: Labels and transparencies are in the
list of Other options.

 

7. Select the option for the type of paper you are
using, and click the OK button.
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Print the first or last page on different paper with Windows
1. On the File menu in the software program, click

Print.
 

2. Select the product, and then click the
Properties or Preferences button.

 

3. Click the Paper/Quality tab.  
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4. In the Special pages area, click the Print
pages on different paper option, and then
click the Settings button.

 

5. In the Pages in document area, select either
the First or Last option.

 

6. Select the correct options from the Paper
source and Paper type drop-down lists. Click
the Add button.
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7. If you are printing both the first and last pages
on different paper, repeat steps 5 and 6,
selecting the options for the other page.

 

8. Click the OK button.  

Scale a document to fit page size
1. On the File menu in the software program, click

Print.
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2. Select the product, and then click the
Properties or Preferences button.

 

3. Click the Effects tab.  

4. Select the Print Document On option, and
then select a size from the drop-down list.
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Add a watermark to a document with Windows
1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Effects tab.

4. Select a watermark from the Watermarks drop-down list.

Or, to add a new watermark to the list, click the Edit button. Specify the settings for the watermark,
and then click the OK button.

5. To print the watermark on the first page only, select the First page only check box. Otherwise, the
watermark is printed on each page.

Create a booklet with Windows
1. On the File menu in the software program, click

Print.
 

2. Select the product, and then click the
Properties or Preferences button.
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3. Click the Finishing tab.  

4. Select the Print on both sides check box.  

5. In the Booklet layout drop-down list, click the
Left binding or Right binding option. The
Pages per sheet option automatically changes
to 2 pages per sheet.
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6. Retrieve the printed stack from the output bin,
and maintaining the same orientation, place it
with the printed side facing down in Tray 2.

 

7. On the control panel, press the OK button to
print the second side of the job.
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8 Color

● Adjust color

● Use the HP EasyColor option for Windows

● Match colors
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Adjust color
Manage color by changing the settings on the Color tab in the printer driver.

Change the color theme for a print job
1. On the File menu in the software program, click Print.

2. Click Properties or Preferences.

3. Click the Color tab.

4. Select a color theme from the Color Themes drop-down list.

● Default (sRGB): This theme sets the product to print RGB data in raw device mode. When
using this theme, manage color in the software program or in the operating system for correct
rendering.

● Vivid: The product increases the color saturation in the midtones. Use this theme when
printing business graphics.

● Photo: The product interprets RGB color as if it were printed as a photograph using a digital
mini lab. The product renders deeper, more saturated colors differently than with the Default
(sRBG) theme. Use this theme when printing photos.

● Photo (Adobe RGB 1998): Use this theme with printing digital photos that use the AdobeRGB
color space rather than sRGB. Turn off color management in the software program when using
this theme.

● None: No color theme is used.

Change the color options
Change the color options settings for the current print job from the color tab of the printer driver.

1. On the File menu in the software program, click Print.

2. Click Properties or Preferences.

3. Click the Color tab.
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4. Click the Automatic or Manual setting.

● Automatic setting: Select this setting for most color print jobs

● Manual setting: Select this setting to adjust the color settings independent from other settings.

NOTE: Changing color settings manually can impact output. HP recommends that only color
graphics experts change these settings.

5. Click the Print in Grayscale option to print a color document in black and shades of gray. Use this
option to print color documents for photocopying or faxing. You can also use this option to print
draft copies or to save color toner.

6. Click the OK button.

Manual color options
Use manual color options to adjust the Neutral Grays, Halftone, and Edge Control options for text,
graphics, and photographs.

Table 8-1  Manual color options

Setting description Setting options

Edge Control

The Edge Control setting determines the rendering
of edges. Edge control has two components: adaptive
halftoning and trapping. Adaptive halftoning
increases edge sharpness. Trapping reduces the
effect of color-plane misregistration by overlapping
the edges of adjacent objects slightly.

● Off turns off both trapping and adaptive halftoning.

● Light sets trapping at a minimal level. Adaptive halftoning is on.

● Normal sets trapping at a medium level. Adaptive halftoning is on.

● Maximum is the most aggressive trapping setting. Adaptive
halftoning is on.
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Setting description Setting options

Halftone

Halftone options affect color output clarity and
resolution.

● Smooth provides better results for large, solid-filled print areas
and enhances photographs by smoothing color gradations. Select
this option when uniform and smooth area fills are important.

● Detail is useful for text and graphics that require sharp distinctions
among lines or colors, or images that contain a pattern or a high
level of detail. Select this option when sharp edges and small
details are important.

Neutral Grays

The Neutral Grays setting determines the method for
creating gray colors used in text, graphics, and
photographs.

● Black Only generates neutral colors (grays and black) by using
only black toner. This guarantees neutral colors without a color
cast. This setting is best for documents and grayscale viewgraphs.

● 4-Color generates neutral colors (grays and black) by combining
all four toner colors. This method produces smoother gradients
and transitions to other colors, and it produces the darkest black.

Use the HP EasyColor option for Windows
If you are using the HP PCL 6 printer driver for Windows, the HP EasyColor technology automatically
improves mixed-content documents that are printed from Microsoft Office programs. This technology
scans documents and automatically adjusts photographic images in .JPEG or .PNG format.
HP EasyColor technology enhances the entire image at one time, rather than dividing it into several
pieces, which results in improved color consistency, sharper details, and faster printing.

In the following example, the images on the left were created without using the HP EasyColor option.
The images on the right show the enhancements that result from using the HP EasyColor option.

The HP EasyColor option is enabled by default in the HP PCL 6 printer driver, so you do not need to
make manual color adjustments. To disable the option so you can manually adjust the color settings,
open the Color tab, and click the HP EasyColor check box to clear it.

Table 8-1  Manual color options (continued)
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Match colors
The process of matching printer output color to your computer screen is complex, because printers and
computer monitors use different methods of producing color. Monitors display colors by using light pixels
that use an RGB (red, green, blue) color process, but printers print colors by using a CMYK (cyan,
magenta, yellow, and black) process.

Several factors can influence your ability to match printed colors to those on your monitor:

● Print media

● Printer colorants (inks or toners, for example)

● Printing process (Inkjet, press, or laser technology, for example)

● Overhead lighting

● Personal differences in perception of color

● Software programs

● Printer drivers

● Computer operating systems

● Monitors

● Video cards and drivers

● Operating environment (humidity, for example)

Keep these factors in mind when colors on your screen do not perfectly match your printed colors.

For most users, the best method for matching colors is to print sRGB colors.
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9 Manage and maintain

● Print information pages

● Use HP ToolboxFX

● Use the HP Embedded Web Server

● Use HP Web Jetadmin software

● Product security features

● Economy settings

● Manage supplies and accessories

● Clean the product

● Product updates
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Print information pages
Information pages reside within the product memory. These pages help diagnose and solve problems
with the product.

NOTE: If the product language was not correctly set during installation, you can set the language
manually so the information pages print in one of the supported languages. Change the language by
using the System Setup menu on the control panel or the embedded Web server.

Menu item Description

Demo page Prints a color page that demonstrates print quality.

Menu structure Prints a map of the control panel-menu layout. The active settings for each menu
are listed.

Config report Prints a list of all the product settings. Includes network information when the product
is connected to a network.

Supplies status Prints the status for each print cartridge, including the following information: 

● Estimated percentage of cartridge life remaining

● Approximate pages remaining

● Part number

● Number of pages printed

● Information about ordering new HP print cartridges and recycling used HP print
cartridges

Network Summary Prints a list of all product network settings

Usage page Prints a page that lists PCL pages, PCL 6 pages, PS pages, pages that were jammed
or mispicked in the product, monochrome (black and white) or color pages; and
reports the page count

HP Color LaserJet CP1525nw only: prints a page that lists the information above,
and the monochrome (black and white) or color pages printed, number of memory
cards inserted, number of PictBridge connections, and the PictBridge page count

PCL font list Prints a list of all the PCL fonts that are installed.

PS font list Prints a list of all the PostScript (PS) fonts that are installed

PCL6 font list Prints a list of all the PCL6 fonts that are installed

Color usage log Prints a report that shows the user name, application name, and color usage
information on a job-by-job basis

Service page Prints the service report

Diagnostics page Prints the calibration and color diagnostics pages

Print Quality Prints a color test page which can be useful for diagnosing print quality defects.

1. Press OK to open the menus.

2. Press the Left arrow  or Right arrow  button to navigate to Reports, and then press OK.
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3. Press the Left arrow  or Right arrow  button to navigate to the report you want to print, and then
press OK to print the report.

4. Press X to exit the menus.
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Use HP ToolboxFX
The HP ToolboxFX is program you can use to complete the following tasks:

● Check the product status.

● Configure the product settings.

● View troubleshooting information.

You can view the HP ToolboxFX program when the product is directly connected to your computer or
is connected to the network. You must perform a recommended software installation to use the HP
ToolboxFX program.

NOTE: The HP ToolboxFX program is not supported for Windows Server 2003, Server 2008, Vista
Starter, or Mac operating systems.

You do not have to have Internet access to open and use the HP ToolboxFX program.

View the HP ToolboxFX
Open the HP ToolboxFX program in one of these ways:

● In the Windows system tray, double-click the HP ToolboxFX icon ( ).

● On the Windows Start menu, click Programs (or All Programs in Windows XP and Vista), click
HP, click the name of this product, and then click the HP ToolboxFX item.

The HP ToolboxFX program contains the following folders:

● Status

● Help

● System settings

● Print settings

● Network Settings
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HP ToolboxFX sections

Status
The Status folder contains links to the following main pages:

● Device status. This page indicates product conditions such as a jam or an empty tray. After you
correct a problem, click Refresh status to update the product status.

● Supplies status. View details such as the estimated percent of life remaining in the print cartridge
and the number of pages printed with the current print cartridge. This page also has links for
ordering supplies and for finding recycling information.

● Device configuration. View a detailed description of the current product configuration, including
the amount of memory installed and whether optional trays are installed.

● Network summary. View a detailed description of the current network configuration, including the
IP address and network status.

● Reports. Print the Configuration page and other information pages, such as the Supplies status
page.

● Color usage job log. View color usage information for the product.

Event log
The event log is a table where the product events are logged for your reference. The log contains codes
that correspond to the error messages that appear on the product control panel display. The number in
the Page Count column specifies the total number of pages that the product had printed when the error
occurred.

Help
The Help folder contains links to the following main pages:

● Color Printing Tools. Open Microsoft Office Basic Colors or the full palette of color with associated
RGB values.

System Settings
The System Settings folder contains links to the following main pages:

● Device Information. View information such as the product description and a contact person.

● Paper Setup. Configure trays or change the product paper-handling settings, such as default paper
size and default paper type.

● Print Quality. Change the print-quality settings.

● Print Density. Change the print-density settings, such as contrast, highlights, midtones, and
shadows.

● Paper Types. Change the mode settings for each paper type, such as letterhead, prepunched, or
glossy paper.

● System Setup. Change the system settings, such as jam recovery and auto continue. Change the
Cartridge low threshold setting, which sets the toner level that causes a low toner alert.
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● Save/Restore Settings. Save the current settings for the product to a file on your computer. Use
this file to load the same settings onto another product or to restore these settings to this product
at a later time.

● Product security. Set a password to protect the device settings. After a password is set, users
are prompted to enter the password before being allowed to change device settings. This password
is the same as the embedded Web server password.

Device Information

The Device Information page stores data about your product for future reference. The information that
you type in the fields on this page displays on the Configuration page. You can type any character in
each of these fields.

NOTE: You must click Apply before your changes take effect.
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Paper Setup

Use these options to configure your default product settings. These are the same options that are
available on the control panel menus.

The following options are available for handling print jobs when the product is out of paper.

● Select the Wait forever option to make the product wait until you load the correct paper and press
the OK button. This is the default setting.

● Select the Cancel option to automatically cancel the print job after a specified delay..

● Select the Override option to print on a different size or type after a specified delay.

If you select either the Override or Cancel options, specify the number of seconds to delay. Press the
Right arrow  button to increase the time, up to 3600 seconds. Press the Left arrow  button to decrease
the time.

The Paper out time field specifies how long the product waits before acting on your selections. You
can specify from 0 to 3600 seconds.

NOTE: You must click Apply before your changes take effect.

Print Quality

Use these options to improve the appearance of your print jobs. These are the same options that are
available on the control panel menus.

Color Calibration

● Power On Calibration. Specify whether the product should calibrate when you turn it on.

● Calibration Timing. Specify how frequently the product should calibrate.

● Calibrate Now. Set the product to calibrate immediately.

NOTE: You must click Apply before your changes take effect.

Print Density

Use these settings to make fine adjustments in the amount of each color of toner that is used for your
printed documents.

● Contrasts. Contrast is the range of difference between light (highlight) and dark (shadow) colors.
To increase the overall range between light and dark colors, increase the Contrasts setting.

● Highlights. Highlights are colors that are nearly white. To darken highlight colors, increase the
Highlights setting. This adjustment does not affect midtone or shadow colors.

● Midtones. Midtones are colors that are halfway between white and solid density. To darken
midtone colors, increase the Midtones setting. This adjustment does not affect highlight or shadow
colors.

● Shadows. Shadows are colors that are nearly solid density. To darken shadow colors, increase
the Shadows setting. This adjustment does not affect highlight or midtone colors.

ENWW Use HP ToolboxFX 91



Paper Types

Use these options to configure print modes that correspond to the various media types. To reset all
modes to factory default settings, select Restore modes.

NOTE: You must click Apply before your changes take effect.
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System Setup

Use these system settings to configure miscellaneous print settings. These settings are not available
on the control panel.

NOTE: You must click Apply before your changes take effect.

Print Settings
The HP ToolboxFX Print Settings tab contains links to the following main pages:

● Printing. Change the default product print settings, such as number of copies and paper
orientation.

● PCL5c. View and change the PCL5c settings.

● PostScript. View and change the PS settings.

Printing

Use these options to configure the settings for all print functions. These are the same options that are
available on the control panel.

NOTE: You must click Apply before your changes take effect.

PCL5c

Use these options to configure the settings when you are using the PCL print personality.

NOTE: You must click Apply before your changes take effect.

PostScript

Use this option when you are using the PostScript print personality. When the Print PostScript error
option is turned on, the PostScript error page automatically prints when PostScript errors occur.

NOTE: You must click Apply before your changes take effect.

Network Settings
The network administrator can use this tab to control the network-related settings for the product when
it is connected to an IP-based network.

NOTE: You cannot configure wireless network settings by using HP ToolboxFX.

Shop for Supplies
This button, at the top of each page, links to a Web site where you can order replacement supplies. You
must have Internet access to use this feature.

Other Links
This section contains links that connect you to the Internet. You must have Internet access to use any
of these links. If you use a dial-up connection and did not connect when you first opened the HP
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ToolboxFX program, you must connect before you can visit these Web sites. Connecting might require
that you close the HP ToolboxFX program and reopen it.

● HP Instant Support. Connects to the HP Instant Support Web site.

● Support and Troubleshooting. Connects to the support site for the product where you can search
for help with a specific problem.

● Product Registration. Connects to the HP product registration Web site.

Use the HP Embedded Web Server
This product is equipped with an embedded Web server (EWS), which provides access to information
about product and network activities. A Web server provides an environment in which web programs
may run, much in the same way that an operating system, such as Windows, provides an environment
for programs to run on a computer. The output from these programs can then be displayed by a Web
browser, such as Microsoft Internet Explorer, Safari, or Netscape Navigator.

An “embedded” Web server resides on a hardware device (such as an HP LaserJet product) or in
firmware, rather than as software that is loaded on a network server.

The advantage of an EWS is that it provides an interface to the product that anyone with a network-
connected product and computer can use. There is no special software to install or configure, but you
must have a supported Web browser on the computer. To gain access to the EWS, type the IP address
for the product in the address line of the browser. To find the IP address, print a configuration page.

NOTE: For Macintosh operating systems, you can use the EWS over a USB connection after installing
the Macintosh software included with the product.

Open the HP Embedded Web Server 
1. In a supported Web browser on your computer, type the IP address for the product in the address/

URL field. (To find the IP address, print a configuration page.

NOTE: After you open the URL, you can bookmark it so that you can return to it quickly in the
future.

2. The embedded Web server has three tabs that contain settings and information about the product:
the Status tab, the Settings tab, and the Networking tab. Click the tab that you want to view.

See the following section for more information about each tab.
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HP Embedded Web Server features
The following sections describe the basic screens of the embedded Web server.

Status tab
Provides product, status, and configuration information.

● Device Status: Shows the product status and shows the life remaining of HP supplies, with 0%
indicating that a supply is empty.

● Supplies Status: Shows the approximate percent life remaining of HP Supplies, with "--" indicating
that the supply is nearing the end of its estimated life, or is too low to determine.

● Device Configuration: Shows the information found on the product Configuration page.

● Network Summary: Shows the information found on the product Network Configuration page.

● Reports: Allows you to print the PCL, PCL6, PS Font Lists, and the supplies status page that the
product generates.

● Color Usage Job Log: Shows user color print jobs on a job-by-job basis.

● Event Log: Shows a list of all product events and errors.

System tab
Provides the ability to configure the product from your computer.

● Device Information: Allows you to name the product and assign an asset number to it. Enter the
name for the primary contact who will receive information about the product.

● Paper Setup: Allows you to change the paper-handling defaults for the product.

● Print Quality: Allows you to change the print quality defaults for the product, including calibration
settings.

● Print Density: Allows you to change the contrasts, highlights, midtones, and shadows values for
each supply.

● Paper Types: Allows you to configure print modes that correspond to the paper types that the
product accepts.

● System Setup: Allows you to change the system defaults for the product.

● Service: Allows you to start the cleaning procedure on the product.

● Product Security: Allows you to set a password for making changes to configuration items.

NOTE: The Settings tab can be password-protected. If this product is on a network, always consult
with the printer administrator before changing settings on this tab.
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Print tab
Provides the ability to configure print settings on the product.

● Printing: Allows you to change the printing defaults for the product.

● PCL 5: Allows you to change the PCL 5 defaults for the product.

● PostScript: Allows you to change the PostScript defaults for the product.

Networking tab
Provides the ability to change network settings from your computer.

Network administrators can use this tab to control network-related settings for the product when it is
connected to an IP-based network. This tab does not appear if the product is directly connected to a
computer.

NOTE: The Networking tab can be password-protected.
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Use HP Web Jetadmin software
HP Web Jetadmin is a Web-based software solution for remotely installing, monitoring, and
troubleshooting network-connected peripherals. Management is proactive, allowing network
administrators the ability to resolve issues before users are affected. Download this free, enhanced-
management software at www.hp.com/go/webjetadmin. 

Device plug-ins can be installed into HP Web Jetadmin to provide support for specific product features.
The HP Web Jetadmin software can automatically notify you when new plug-ins are available. On the
Product Update page, follow the directions to automatically connect to the HP Web site and install the
latest device plug-ins for your product.

NOTE: Browsers must be Java™-enabled. Browsing from a Mac OS is not supported.

Product security features
The product supports security standards and recommended protocols that help you keep the product
secure, protect critical information on your network, and simplify the way you monitor and maintain the
product.

For in-depth information about HP's secure imaging and printing solutions, visit www.hp.com/go/
secureprinting. The site provides links to white papers and FAQ documents about security features.

Assign a system password
Assign a password for the product so that unauthorized users cannot change the product settings.

1. Open the HP Embedded Web Server by entering the product IP address into the address line of
a Web browser.

2. Click the Settings tab.

3. On the left side of the window, click the Security menu.

4. In the Device Security Settings area, click the Configure . . . button.

5. In the Device Password area, type the password in the New Password box, and type it again in
the Verify password box.

6. Click the Apply button. Make note of the password and store it in a safe place.
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Economy settings
Powersave modes

The adjustable sleep mode feature reduces power consumption when the product has been inactive for
an extended period. You can set the length of time before the product enters sleep mode.

NOTE: This mode does not affect product warm-up time.

Set sleep delay mode
1. On the control panel, press the OK button and select the System Setup menu.

2. Select the PowerSave Time menu.

3. Select the Sleep Delay sub-menu item.

4. Scroll to and touch the 15 minutes button, and then select the setting that you want to use.

Archive print
Archive print produces output that is less susceptible to toner smearing and dusting. Use archive print
to create documents that you want to preserve or archive.

1. On the control panel, press the OK button and select the Service menu.

2. Use the arrow buttons to select the Archive print option, select the On or Off choice, and then
press the OK button.

Manage supplies and accessories
Print when a print cartridge reaches estimated end of life

Supplies messages
Supply-related notifications are communicated on the product control panel and on computers that have
the full product software installed. If the full product software is not installed, you might not receive all
supply-related notifications in a prominent manner. To install the full product software, insert the CD that
came with the product and follow the steps for the full install.

A <Supply> Low message—where <Supply> is the color print cartridge: The product indicates when
a supply level is low. Actual cartridge life remaining may vary. Consider having a replacement available
to install when print quality is no longer acceptable. The supply does not need to be replaced now.

A <Supply> Very Low message. The product indicates when a supply level is very low. Actual cartridge
life remaining may vary. Consider having a replacement available to install when print quality is no longer
acceptable. The supply does not need to be replaced now unless the print quality is no longer
acceptable. Once an HP supply has reached “Very Low”, HP’s premium Protection Warranty on that
supply has ended.

Print-quality problems can occur when using a print cartridge that is at its estimated end of life. The
supply does not need to be replaced at this point in time unless the print quality is no longer acceptable.

NOTE: Using the Continue setting allows printing beyond Very Low without customer interaction and
can result in unsatisfactory print quality.
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Enable or disable the At Very Low settings from the control panel
You can enable or disable the default setting at any time, and you do not have to re-enable it when you
install a new print cartridge.

1. On the control panel, press the OK button.

2. Use the arrow buttons to select the System Setup menu, and then press the OK button.

3. Use the arrow buttons to select the At Very Low menu, and then press the OK button.

4. Use the arrow buttons to select the Black Cartridge menu or the Color Cartridges menu, and
then press the OK button.

5. Select one of the following options.

● Select the Continue option to set the product to alert you that the print cartridge is very low,
but to continue printing.

● Select the Stop option to set the product to stop printing until you replace the print cartridge.

● Select the Prompt option to set the product to stop printing and prompt you to replace the
print cartridge. You can acknowledge the prompt and continue printing.

● On the Color Cartridges menu only, select Print Black (the default option) to alert you when
the print cartridge is very low, but to continue printing in black only.

Once an HP supply has reached “very low’, HP’s premium Protection Warranty on that supply has
ended.

Manage print cartridges

Print-cartridge storage
Do not remove the print cartridge from its package until you are ready to use it.

CAUTION: To prevent damage to the print cartridge, do not expose it to light for more than a few
minutes.

HP policy on non-HP print cartridges
Hewlett-Packard Company cannot recommend the use of non-HP print cartridges, either new or
remanufactured.

NOTE: Any damage caused by a non-HP print cartridge is not covered under the HP warranty and
service agreements.

HP fraud hotline and Web site
Call the HP fraud hotline (1-877-219-3183, toll-free in North America) or go to www.hp.com/go/
anticounterfeit when you install an HP print cartridge and the control-panel message says the cartridge
is non-HP or used. HP will help determine if the cartridge is genuine and take steps to resolve the
problem.
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Your print cartridge might not be a genuine HP print cartridge if you notice the following:

● The supplies status page indicates that a non-HP or used supply is installed.

● You are experiencing a high number of problems with the print cartridge.

● The cartridge does not look like it usually does (for example, the packaging differs from
HP packaging).

Recycle supplies
To recycle a genuine HP print cartridge, place the used cartridge in the box in which the new cartridge
arrived. Use the enclosed return label to send the used supply to HP for recycling. For complete
information, see the recycling guide that is included with each new HP supply item.

Print cartridge layout

1 Print cartridge memory chip

2 Plastic shield

3 Imaging Drum. Do not touch the imaging drum on the bottom of the print cartridge. Fingerprints on the imaging drum can
cause print-quality problems.
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Replacement instructions

Replace print cartridges

1. Open the front door.  

2. Pull out the print cartridge drawer.  

3. Grasp the handle on the old print cartridge and
then pull the print cartridge straight up to
remove it.
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4. Remove the new print cartridge from the
packaging.

 

5. Gently rock the print cartridge from front to back
to distribute the toner evenly inside the print
cartridge.

 

6. Remove the orange, plastic shield from the
bottom of the new print cartridge.
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7. Do not touch the imaging drum on the bottom
of the print cartridge. Fingerprints on the
imaging drum can cause print-quality
problems.

 

8. Insert the new print cartridge into the product.  

9. Pull the tab on the left side of the print cartridge
straight up to completely remove the sealing
tape. Discard the sealing tape.
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10. Close the print cartridge drawer.  

11. Close the front door.  

12. Place the old print cartridge and the orange
plastic shield in the box for the new print
cartridge. Follow the recycling instructions that
are included in the box.
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Install memory DIMMs
This product comes with 64-megabyte (MB) random-access memory installed. You can install up to
256-megabyte of memory for the product by adding a dual inline memory module (DIMM). You can also
install a font DIMM to allow the product to print characters (for example, Chinese language or the Cyrillic
alphabet characters).

CAUTION: Static electricity can damage electronic parts. When handling electronic parts, either wear
an antistatic wrist strap, or frequently touch the surface of the antistatic package and then touch bare
metal on the product.

Install memory DIMMs
1. Turn the product off, and then disconnect all power and interface cables.

2. On the right side of the product, open the DIMM access door.

3. To replace a DIMM that is currently installed, spread the latches apart on each side of the DIMM
slot, lift the DIMM up at an angle, and pull it out.
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4. Remove the new DIMM from the antistatic package, and then locate the alignment notch on the
bottom edge of the DIMM.

5. Holding the DIMM by the edges, align the notch on the DIMM with the bar in the DIMM slot at an
angle.

6. Push down on the DIMM until both latches engage the DIMM. When the installation is correct, the
metal contacts are not visible.

NOTE: If you have difficulty inserting the DIMM, make sure that the notch on the bottom of the
DIMM is aligned with the bar in the slot. If the DIMM still does not go in, make sure that you are
using the correct DIMM type.
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7. Close the DIMM access door.

8. Reconnect the power cable and USB or network cable, and then turn on the product.

Enable memory

Windows XP, Windows Server 2003,
Windows Server 2008, and Windows
Vista

1. Click Start.

2. Click Settings.

3. Click Printers and Faxes (using the default Start menu view) or click
Printers (using the Classic Start menu view).

4. Right-click the product driver icon, and then select Properties.

5. Click the Device Settings tab.

6. Expand the area for Installable Options.

7. Next to Automatic Configuration, select Update Now.

8. Click OK.

NOTE: If the memory is not updated correctly after using the Update Now option,
you can manually select the total amount of memory installed in the product in the
Installable Options area.

The Update Now option overwrites any existing product configuration settings.
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Windows 7 1. Click Start.

2. Click Devices and Printers.

3. Right-click the product driver icon, and then select Printer properties.

4. Click the Device Settings tab.

5. Expand the area for Installable Options.

6. Next to Automatic Configuration, select Update Now.

7. Click OK.

NOTE: If the memory is not updated correctly after using the Update Now option,
you can manually select the total amount of memory installed in the product in the
Installable Options area.

The Update Now option overwrites any existing product configuration settings.

Mac OS X 10.5 and 10.6 1. From the Apple menu , click the System Preferences menu and then click
the Print & Fax icon.

2. Select the product in the left side of the window.

3. Click the Options & Supplies button.

4. Click the Driver tab.

5. Configure the installed options.

Check DIMM installation
After installing the DIMM, make sure that the installation was successful.

1. Turn the product on. Check that the Ready light is illuminated after the product has gone through
the startup sequence. If an error message appears, a DIMM might have been incorrectly installed.

2. Print a configuration page.

3. Check the memory section on the configuration page and compare it to the configuration page that
was printed before the memory installation. If the amount of memory has not increased, the DIMM
might not be installed correctly, or the DIMM might be defective. Repeat the installation procedure.
If necessary, install a different DIMM.

NOTE: If you installed a product language (personality), check the "Installed Personalities and
Options" section on the configuration page. This area should list the new product language.

Memory allocation
Utilities or jobs that you download to the product sometimes include resources (for example, fonts,
macros, or patterns). Resources that are internally marked as permanent remain in the product memory
until you turn the product off.
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Use the following guidelines if you use the page description language (PDL) ability to mark resources
as permanent. For technical details, see an appropriate PDL reference for PCL or PS.

● Mark resources as permanent only when it is absolutely necessary that they remain in memory
while the product is turned on.

● Send permanent resources to the product only at the beginning of a print job and not while the
product is printing.

NOTE: Overusing permanent resources or downloading them while the product is printing might affect
product performance or the ability to print complex pages.
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Clean the product
During the printing process, paper, toner, and dust particles can accumulate inside the product. Over
time, this buildup can cause print-quality problems such as toner specks or smearing. This product has
a cleaning mode that can correct and prevent these problems.

1. At the product control panel, press the OK button.

2. Press the right arrow  to highlight the Service menu, and then press the OK button.

3. Press the right arrow  to highlight the Cleaning Page option, and then press the OK button.

Product updates
Software and firmware updates and installation instructions for this product are available at
www.hp.com/support/ljcp1520series. Click Downloads and drivers, click the operating system, and
then select the download for the product.
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10 Solve problems

● Self help

● Solve problems checklist

● Factors that affect product performance

● Restore factory-settings

● Interpret control panel messages

● Paper feeds incorrectly or becomes jammed

● Solve image quality problems

● The product does not print or it prints slowly

● Solve connectivity problems

● Solve wireless network problems

● Solve product software problems
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Self help
In addition to the information in this guide, other sources are available that provide helpful information.

HP Help and Learn Center The HP Help and Learn Center and other documentation are on the CD that came
with the product or in the HP Program folder on your computer. The HP Help and
Learn Center is a product help tool that provides easy access to product information,
HP product web support, troubleshooting, and regulatory and safety information.

Quick Reference Topics Several Quick Reference Topics for this product are available at this Web site:
www.hp.com/support/ljcp1520series

You can print these topics and keep them near the product. They are a handy
reference for procedures that you perform frequently.

Control panel help The control panel has built-in help that guides you through several tasks, such as
replacing print cartridges and clearing jams.
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Solve problems checklist
1. Make sure that the product is set up correctly.

a. Press the power button to turn on the product or to deactivate the Auto-Off mode.

b. Check the power-cable connections.

c. Make sure that the line voltage is correct for the product power configuration. (See the label
that is on the back of the product for voltage requirements.) If you are using a power strip and
its voltage is not within specifications, plug the product directly into the wall. If it is already
plugged into the wall, try a different outlet.

d. If none of these measures restores power, contact HP Customer Care.

2. Check the cabling.

a. Check the cable connection between the product and the computer. Make sure that the
connection is secure.

b. Make sure that the cable itself is not faulty by using a different cable, if possible.

c. Check the network connection (HP Color LaserJet CP1525nw only): Make sure the network
light is lit. The network light is next to the network port on the back of the product.

If the product remains unable to connect to the network, uninstall and then reinstall the
product. If the error persists, contact a network administrator.

3. HP Color LaserJet CP1525n: Check to see if any control panel lights are lit.

HP Color LaserJet CP1525nw: Check to see if any messages appear on the control panel.

4. Make sure that the paper that you are using meets specifications.

5. Make sure that the paper is loaded correctly in the input tray.

6. Make sure that the product software is installed correctly.

7. Verify that you have installed the printer driver for this product, and that you are selecting this
product from the list of available printers.

8. Print a configuration page.

a. If the page does not print, verify that the input tray contains paper and that the paper is properly
loaded.

b. Make sure that the print cartridge is installed correctly.
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c. If the page jams in the product, clear the jam.

d. If the print quality is unacceptable, complete the following steps:

● Verify that the print settings are correct for the paper that you are using.

● Solve print-quality problems.

9. Print a small document from a different program that has worked in the past. If this solution works,
then the problem is with the program you are using. If this solution does not work (the document
does not print), complete these steps:

a. Try printing the job from another computer that has the product software installed.

b. Check the cable connection. Direct the product to the correct port, or reinstall the software,
selecting the connection type that you are using.
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Factors that affect product performance
Several factors affect the time it takes to print a job:

● The use of special paper (such as transparencies, heavy paper, and custom-size paper)

● Product processing and download time

● The complexity and size of graphics

● The speed of the computer you are using

● The USB or network connection

● The product I/O configuration
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Restore factory-settings 
Restoring the factory-set defaults returns all of the product and network settings to the factory defaults.
It will not reset the page count, tray size, or language. To restore the product to the factory-default
settings, follow these steps.

CAUTION: Restoring the factory-set defaults returns all of the settings to the factory defaults, and it
also deletes any pages that are stored in the memory. The procedure then automatically restarts the
product.

1. On the product control panel, press the OK button.

2. Use the arrows buttons to select the Service menu, and then press the OK button.

3. Use the arrows buttons to select the Restore defaults option, and then press the OK button.

The product automatically restarts.
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Interpret control panel messages
Control panel message types

The control panel messages indicate the current product status or situations that might require action.

Alert and warning messages appear temporarily and might require you to acknowledge the message
by pressing the OK button to resume or by pressing the Cancel  button to cancel the job. With certain
warnings, the job might not complete or the print quality might be affected. If the alert or warning message
is related to printing and the auto-continue feature is on, the product will attempt to resume the printing
job after the warning has appeared for 10 seconds without acknowledgement.

Critical error messages can indicate some kind of failure. Turning off and then turning on the power
might fix the problem. If a critical error persists, the product might require service.

Status-alert messages appear on the computer screen (in addition to control panel messages) when
the product has certain problems. If a status-alert message is available, a  appears in the Status
alert column in the following table.

Control panel messages

Control panel message Status alert Description Recommended action

10.XXXX Supply error The e-label for one of the print
cartridges cannot be read or is
missing.

● 10.0000 = black e-label
error

● 10.0001 = cyan e-label error

● 10.0002 = magenta e-label
error

● 10.0003 = yellow e-label
error

● 10.1000 = black e-label is
missing

● 10.1001 = cyan e-label is
missing

● 10.1002 = magenta e-label
is missing

● 10.1003 = yellow e-label is
missing

Reinstall the print cartridge.

Turn the product off and then on.

If the problem is not solved,
replace the print cartridge.
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Control panel message Status alert Description Recommended action

49 Error

Turn off then on

The product experienced an
internal error.

Turn the product off, wait at least
30 seconds, and then turn the
product on and wait for it to
initialize.

If you are using a surge protector,
remove it. Plug the product
directly into the wall socket. Turn
the product power on.

If the message persists, contact
HP support.

50.X Fuser error

Turn off then on

The product has experienced an
error with the fuser.

Turn the product power off, wait
at least 30 seconds, and then turn
the product power on and wait for
it to initialize.

Turn off the product, wait at least
25 minutes, and then turn on the
product.

If you are using a surge protector,
remove it. Plug the product
directly into the wall socket. Turn
the product power on.

If the message persists, contact
HP support.

51.XX Error

Turn off then on

The product has experienced an
internal hardware error.

Turn the product power off, wait
at least 30 seconds, and then turn
the product power on and wait for
it to initialize.

If you are using a surge protector,
remove it. Plug the product
directly into the wall socket. Turn
the product on.

If the message persists, contact
HP support.

54.XX Error

Turn off then on

The product has experienced an
error with one of the internal
sensors.

Turn the product power off, wait
at least 30 seconds, and then turn
the product power on and wait for
it to initialize.

If you are using a surge protector,
remove it. Plug the product
directly into the wall socket. Turn
the product power on.

If the message persists, contact
HP support.
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Control panel message Status alert Description Recommended action

55.X Error

Turn off then on

The product has experienced an
internal error.

Turn the product power off, wait
at least 30 seconds, and then turn
the product power on and wait for
it to initialize.

If you are using a surge protector,
remove it. Plug the product
directly into the wall socket. Turn
the product power on.

If the message persists, contact
HP support.

57 Fan error

Turn off then on

The product has experienced a
problem with its internal fan.

Turn the product power off, wait
at least 30 seconds, and then turn
the product power on and wait for
it to initialize.

If you are using a surge protector,
remove it. Plug the product
directly into the wall socket. Turn
the product power on.

If the message persists, contact
HP support.

59.X Error

Turn off then on

The product has experienced a
problem with one of the motors.

Turn the product power off, wait
at least 30 seconds, and then turn
the product power on and wait for
it to initialize.

If you are using a surge protector,
remove it. Plug the product
directly into the wall socket. Turn
the product power on.

If the message persists, contact
HP support.

79 Error

Turn off then on

The product has experienced an
internal firmware error.

Turn the product power off, wait
at least 30 seconds, and then turn
the product power on and wait for
it to initialize.

If you are using a surge protector,
remove it. Plug the product
directly into the wall socket. Turn
the product power on.

If the message persists, contact
HP support.

79 Service error

Turn off then on

An incompatible DIMM is
installed.

1. Turn the product power off.

2. Install a DIMM that the
product supports.

3. Turn the product on.

If the message persists, contact
HP support.
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Control panel message Status alert Description Recommended action

Black Cartridge Low The print cartridge is nearing the
end of its useful life.

Printing can continue, but
consider having a replacement
supply on hand.

Black in wrong position A print cartridge is installed in the
incorrect slot.

Be sure that each print cartridge
is in the correct slot. From front to
rear, the print cartridges are
installed in this order: black,
cyan, magenta, yellow.

Black in wrong position The print cartridge is installed in
the incorrect slot.

Make sure that each print
cartridge is installed in the correct
slot. From front to back, the print
cartridges are installed in this
order: black, cyan, magenta, and
yellow.

Black Very Low The print cartridge is at the end of
its useful life, and the At Very
Low menu item in the System
Setup menu is set to Continue.

To ensure optimal print quality,
HP recommends replacing the
print cartridge at this point. You
can continue printing until you
notice a decrease in print quality.
Actual cartridge life may vary.

Once an HP supply has reached
“very low”, HP's premium
Protection Warranty on that
supply has ended. All print
defects or cartridge failures
incurred when an HP supply is
used in continue at very low
mode will not be considered to be
defects in materials or
workmanship in the supply under
the HP Print Cartridge Warranty
Statement.

Cyan Cartridge Low The print cartridge is nearing the
end of its useful life.

Printing can continue, but
consider having a replacement
supply on hand.

Cyan in wrong position A print cartridge is installed in the
incorrect slot.

Be sure that each print cartridge
is in the correct slot. From front to
rear, the print cartridges are
installed in this order: black,
cyan, magenta, yellow.

Cyan in wrong position The print cartridge is installed in
the incorrect slot.

Make sure that each print
cartridge is installed in the correct
slot. From front to back, the print
cartridges are installed in this
order: black, cyan, magenta, and
yellow.
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Control panel message Status alert Description Recommended action

Cyan Very Low The print cartridge is at the end of
its useful life, and the At Very
Low menu item in the System
Setup menu is set to Continue.

To ensure optimal print quality,
HP recommends replacing the
print cartridge at this point. You
can continue printing until you
notice a decrease in print quality.
Actual cartridge life may vary.

Once an HP supply has reached
“very low”, HP's premium
Protection Warranty on that
supply has ended. All print
defects or cartridge failures
incurred when an HP supply is
used in continue at very low
mode will not be considered to be
defects in materials or
workmanship in the supply under
the HP Print Cartridge Warranty
Statement.

Device error

Press [OK]

An internal error occurred. Press OK to resume the job.

Front door open The product front door is open. Close the door.

Genuine HP supply installed A genuine HP supply was
installed. This message will
appear briefly after the supply is
installed and then be replaced by
the message Ready.

No action necessary.

Incorrect supplies More than one print cartridge is
installed in the incorrect slot.

Be sure that each print cartridge
is in the correct slot. From top to
bottom, the print cartridges are
installed in this order: yellow,
magenta, cyan, black.

Install <Color> cartridge The print cartridge is either not
installed or not correctly installed
in the product.

Install the print cartridge.

Invalid driver

Press [OK]

You are using an incorrect printer
driver.

Select the correct printer driver.

Jam in <location> The product has detected a jam. Clear the jam from the location
indicated. The job should
continue to print. If it does not, try
reprinting the job.

If the message persists, contact
HP support.

Jam in tray #

Clear jam and then Press [OK]

The product has detected a jam. Clear the jam from the location
indicated, and then press OK.

If the message persists, contact
HP support.

Load paper Tray 2 is empty. Load paper into Tray 2.
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Control panel message Status alert Description Recommended action

Load tray # <TYPE> <SIZE> A tray is configured for the paper
type and size that the print job is
requesting, but that tray is empty.

Load the correct paper into the
tray, or press OK to use paper in
a different tray.

Load tray 1 plain <SIZE>

Cleaning Page [OK] to start

The product is ready to process
the cleaning operation.

Load Tray 1 with plain paper in
the size indicated, and then press
OK.

Load tray 1 <TYPE> <SIZE> No trays are configured for the
paper type and size that the print
job is requesting.

Load the correct paper into
Tray 1, or press OK to use paper
in a different tray.

Magenta Cartridge Low The print cartridge is nearing the
end of its useful life.

Printing can continue, but
consider having a replacement
supply on hand.

Magenta in wrong position A print cartridge is installed in the
incorrect slot.

Be sure that each print cartridge
is in the correct slot. From front to
rear, the print cartridges are
installed in this order: black,
cyan, magenta, yellow.

Magenta in wrong position The print cartridge is installed in
the incorrect slot.

Make sure that each print
cartridge is installed in the correct
slot. From front to back, the print
cartridges are installed in this
order: black, cyan, magenta, and
yellow.

Magenta Very Low The print cartridge is at the end of
its useful life, and the At Very
Low menu item in the System
Setup menu is set to Continue.

To ensure optimal print quality,
HP recommends replacing the
print cartridge at this point. You
can continue printing until you
notice a decrease in print quality.
Actual cartridge life may vary.

Once an HP supply has reached
“very low”, HP's premium
Protection Warranty on that
supply has ended. All print
defects or cartridge failures
incurred when an HP supply is
used in continue at very low
mode will not be considered to be
defects in materials or
workmanship in the supply under
the HP Print Cartridge Warranty
Statement.

Manual duplex

Load tray # Press [OK]

The first side of a manual duplex
job has printed, and the page
needs to be loaded to process the
second side.

Load the page in the indicated
tray with the side to be printed
face up, and the top of the page
away from you and then press
OK.

Manual feed <TYPE> <SIZE>

Press [OK] for available media

The product is set for manual
feed mode.

Press OK to clear the message
or load the correct paper into
Tray 1.

Memory is low

Press [OK]

The product memory is almost
full.

Press OK to finish the job, or
press X to cancel the job.

Break the job into smaller jobs
that contain fewer pages.
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Control panel message Status alert Description Recommended action

Misprint

Press [OK]

Paper has been delayed as it
moves through the product.

Press OK to clear the message.

Non HP supply installed A non-HP supply is installed. If you believe you purchased an
HP supply, go to www.hp.com/
go/anticounterfeit.

Service or repairs that are
required as a result of using non-
HP supplies are not covered
under HP warranty.

Print failure

Press [OK] If error repeats turn
off then on

The product cannot process the
page.

Press OK to continue printing the
job, but output might be affected.

If the error persists, turn the
power off and then on. Resend
the print job.

Rear door open The product rear door is open. Close the door.

Remove shipping locks from
<color> cartridge

A print cartridge shipping lock is
installed.

Be sure that the print cartridge
shipping lock has been removed.

Remove shipping locks from
all cartridges

A print cartridge shipping lock is
installed on one or more print
cartridges.

Be sure that each print cartridge
shipping lock (orange pull tab on
the left end of new print
cartridges) has been removed.

Replace <color> The print cartridge is at the end of
its useful like, and the At Very
Low menu item in the System
Setup menu is set to Stop.

To ensure optimal print quality,
HP recommends replacing the
print cartridge at this point. You
can continue printing until you
notice a decrease in print quality.
Actual cartridge life may vary.
Once an HP supply has reached
"very low", HP's premium
Protection Warranty on that
supply has ended. All print
defects or cartridge failures
incurred when an HP supply is
used in continue at very low
mode will not be considered to be
defects in materials or
workmanship in the supply under
the HP Print Cartridge Warranty
Statement.

Supplies low More than one supply item is low. Check the supply level gauges on
the control panel, or print a
supplies status page to
determine which print cartridges
are low.

Printing will continue until a ”Very
Low” message displays.
Consider having replacement
supplies on hand.

Unexpected size in tray #

Load [size]  Press [OK]

The product has detected paper
in the tray that does not match the
configuration for the tray.

Load the correct paper into the
tray, or configure the tray for the
size that you have loaded.
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Control panel message Status alert Description Recommended action

Unsupported [color] installed

Press [OK] to continue

The product has detected that a
print cartridge not made by HP
has been installed.

Touch the OK button to continue
printing.

If you believe you purchased an
HP supply, please call the HP
Fraud hotline at 1-877-219-3183.
Service or repairs that are
required as a result of using non-
HP supplies is not covered under
HP warranty.

Used <color> Cartridge in use A print cartridge reached the
default low threshold while it was
installed in a product.

No action necessary.

Used supplies in use A print cartridge reached the
default low threshold while it was
installed in a product.

No action necessary.

Used supply installed

To accept Press [OK]

A print cartridge reached the
default low threshold while it was
installed in a product.

Press OK to continue.

Yellow Cartridge Low The print cartridge is nearing the
end of its useful life.

Printing can continue, but
consider having a replacement
supply on hand.

Yellow in wrong position A print cartridge is installed in the
incorrect slot.

Be sure that each print cartridge
is in the correct slot. From front to
rear, the print cartridges are
installed in this order: black,
cyan, magenta, yellow.

Yellow in wrong position The print cartridge is installed in
the incorrect slot.

Make sure that each print
cartridge is installed in the correct
slot. From front to back, the print
cartridges are installed in this
order: black, cyan, magenta, and
yellow.

Yellow Very Low The print cartridge is at the end of
its useful life, and the At Very
Low menu item in the System
Setup menu is set to Continue.

To ensure optimal print quality,
HP recommends replacing the
print cartridge at this point. You
can continue printing until you
notice a decrease in print quality.
Actual cartridge life may vary.

Once an HP supply has reached
“very low”, HP's premium
Protection Warranty on that
supply has ended. All print
defects or cartridge failures
incurred when an HP supply is
used in continue at very low
mode will not be considered to be
defects in materials or
workmanship in the supply under
the HP Print Cartridge Warranty
Statement.
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Paper feeds incorrectly or becomes jammed
● The product does not pick up paper

● The product picks up multiple sheets of paper

● Prevent paper jams

● Clear jams

The product does not pick up paper
If the product does not pick up paper from the tray, try these solutions.

1. Open the product and remove any jammed sheets of paper.

2. Load the tray with the correct size of paper for your job.

3. Make sure the paper guides in the tray are adjusted correctly for the size of paper. Adjust the guides
so they are touching the paper stack without bending it.

4. Check the product control panel to see if the product is waiting for you to acknowledge a prompt
to feed the paper manually. Load paper, and continue.

The product picks up multiple sheets of paper
If the product picks up multiple sheets of paper from the tray, try these solutions.

1. Remove the stack of paper from the tray and flex it, rotate it 180 degrees, and flip it over. Do not
fan the paper. Return the stack of paper to the tray.

2. Use only paper that meets HP specifications for this product.

3. Use paper that is not wrinkled, folded, or damaged. If necessary, use paper from a different
package.

4. Make sure the tray is not overfilled. If it is, remove the entire stack of paper from the tray, straighten
the stack, and then return some of the paper to the tray.

5. Make sure the paper guides in the tray are adjusted correctly for the size of paper. Adjust the guides
so they are touching the paper stack without bending it.

Prevent paper jams
To reduce the number of paper jams, try these solutions.

1. Use only paper that meets HP specifications for this product.

2. Use paper that is not wrinkled, folded, or damaged. If necessary, use paper from a different
package.

3. Use paper that has not previously been printed or copied on.

4. Make sure the tray is not overfilled. If it is, remove the entire stack of paper from the tray, straighten
the stack, and then return some of the paper to the tray.

5. Make sure the paper guides in the tray are adjusted correctly for the size of paper. Adjust the guides
so they are touching the paper stack without bending it.
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6. Make sure that the tray is fully inserted in the product.

7. If you are printing on heavy, embossed, or perforated paper, use the manual feed feature and feed
sheets one at a time.

Clear jams

Jam locations
Use this illustration to find the locations of jams.

1

3

2

1 Output bin

2 Rear door

3 Trays
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Jam in Tray 1
NOTE: If the sheet tears, remove all fragments before resuming printing.

1. If you can see the jammed sheet, remove the
jammed sheet by pulling it straight out.

 

2. If you cannot see the jammed sheet, open the
Tray 1 door and pull out Tray 2.

 

3. Push down on two tabs to release the Tray 1
panel.
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4. Remove the jammed sheet by pulling it straight
out.

CAUTION: Do not pull up on the jammed
sheet. Be sure to pull it straight out.

 

5. Push up on two tabs to replace the Tray 1
panel.

 

6. Replace Tray 2  
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Jam in Tray 2

1. Pull out Tray 2 and place it on a flat surface.  

2. Remove the jammed sheet by pulling it straight
out.

 

3. Replace Tray 2.  

4. Press OK to continue printing.  
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Jam in the fuser area

1. Open the rear door.  

2. Remove any jammed sheets.

NOTE: If the sheet tears, remove all
fragments before resuming printing.

CAUTION: Wait until the fuser area has
cooled before clearing the jam.

 

3. Close the rear door.  
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Jam in the output bin

1. Look for jammed paper in the output bin area.  

2. Remove any visible paper.

NOTE: If the sheet tears, remove all
fragments before resuming printing.

 

3. Open and then close the rear door to clear the
message.
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Solve image quality problems
You can prevent most print-quality problems by following these guidelines.

● Use the correct paper type setting in the printer driver

● Adjust color settings in the printer driver

● Use paper that meets HP specifications

● Print a cleaning page

● Calibrate the product to align the colors

● Check the print cartridges

● Use the printer driver that best meets your printing needs

Use the correct paper type setting in the printer driver
Check the paper type setting if you are having any of the following problems:

● Toner is smearing on the printed pages.

● Repeated marks occur on the printed pages.

● Printed pages are curled.

● Toner flakes off the printed pages.

● Printed pages have small unprinted areas.

Change the paper type setting for Windows
1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Paper/Quality tab.

4. From the Paper type drop-down list, click the More... option.

5. Expand the list of Type is: options.

6. Expand each category of paper types until you find the paper type that you are using.

7. Select the option for the type of paper you are using, and click the OK button.

Change the paper type setting for Mac
1. On the File menu in the software program, click the Print option.

2. In the Copies & Pages menu, click the Page Setup button.

3. Select a size from the Paper Size drop-down list, and then click the OK button.

4. Open the Finishing menu.
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5. Select a type from the Media-type drop-down list.

6. Click the Print button.

Adjust color settings in the printer driver

Change the color theme for a print job
1. On the File menu in the software program, click Print.

2. Click Properties or Preferences.

3. Click the Color tab.

4. Select a color theme from the Color Themes drop-down list.

● Default (sRGB): This theme sets the product to print RGB data in raw device mode. When
using this theme, manage color in the software program or in the operating system for correct
rendering.

● Vivid: The product increases the color saturation in the midtones. Use this theme when
printing business graphics.

● Photo: The product interprets RGB color as if it were printed as a photograph using a digital
mini lab. The product renders deeper, more saturated colors differently than with the Default
(sRBG) theme. Use this theme when printing photos.

● Photo (Adobe RGB 1998): Use this theme with printing digital photos that use the AdobeRGB
color space rather than sRGB. Turn off color management in the software program when using
this theme.

● None

Change the color options
Change the color options settings for the current print job from the color tab of the printer driver.

1. On the File menu in the software program, click Print.

2. Click Properties or Preferences.
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3. Click the Color tab.

4. Click the Automatic or Manual setting.

● Automatic setting: Select this setting for most color print jobs

● Manual setting: Select this setting to adjust the color settings independent from other settings.

NOTE: Changing color settings manually can impact output. HP recommends that only color
graphics experts change these settings.

5. Click the Print in Grayscale option to print a color document in black and white. Use this option
to print color documents for photocopying or faxing.

6. Click the OK button.

Use paper that meets HP specifications
Use different paper if you are having any of the following problems:

● The printing is too light or seems faded in areas.

● Specks of toner are on the printed pages.

● Toner is smearing on the printed pages.

● Printed characters seem misformed.

● Printed pages are curled.

Always use a paper type and weight that this product supports. In addition, follow these guidelines when
selecting paper:

● Use paper that is of good quality and free of cuts, nicks, tears, spots, loose particles, dust, wrinkles,
voids, staples, and curled or bent edges.

● Use paper that has not been previously printed on.

● Use paper that is designed for use in laser printers. Do not use paper that is designed only for use
in Inkjet printers.

● Use paper that is not too rough. Using smoother paper generally results in better print quality.
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Print a cleaning page
Print a cleaning page to remove dust and excess toner from the paper path if you are having any of the
following problems:

● Specks of toner are on the printed pages.

● Toner is smearing on the printed pages.

● Repeated marks occur on the printed pages.

Use the following procedure to print a cleaning page.

1. At the product control panel, press the OK button.

2. Press the right arrow  to highlight the Service menu, and then press the OK button.

3. Press the right arrow  to highlight the Cleaning Page option, and then press the OK button.

Calibrate the product to align the colors
If the printed output has colored shadows, blurry graphics, or areas that have poor color, you might need
to calibrate the product to align the colors. Print the Diagnostics Page from the Reports menu on the
control panel to check the color alignment. If the blocks of color on that page are not aligned with each
other, you need to calibrate the product.

1. On the product control panel, open the System Setup menu.

2. Open the Print quality menu, and select the Calibrate color item.

3. Select the Calibrate now option.

Check the print cartridges
Check each print cartridge, and replace it if necessary, if you are having any of the following problems:

● The printing is too light or seems faded in areas.

● Printed pages have small unprinted areas.

● Printed pages have streaks or bands.

If you determine that you need to replace a print cartridge, print the Supplies Status Page to find the
part number for the correct genuine HP print cartridge.
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Type of print cartridge Steps to resolve the problem

Refilled or remanufactured print
cartridge

Hewlett Packard Company cannot recommend the use of non-HP supplies, either
new or remanufactured. Because they are not HP products, HP cannot influence
their design or control their quality. If you are using a refilled or remanufactured print
cartridge and are not satisfied with the print quality, replace the print cartridge with
a genuine HP print cartridge that has the words “HP” or “Hewlett-Packard” on it, or
has the HP logo on it.

Genuine HP print cartridge 1. The product control panel or the Supplies status page indicates Very Low
status when the print cartridge has reached the end of its estimated life.
Replace the print cartridge if print quality is no longer acceptable.

2. Print a Print Quality Page from the Reports menu on the control panel. If
streaks or marks are in one color on the page, you might have a defect in that
color cartridge. See the instructions in this document for interpreting the page.
Replace the print cartridge if necessary.

3. Visually inspect the print cartridge for damage. See the instructions that follow.
Replace the print cartridge if necessary.

4. If printed pages have marks that repeat several times at the same distance
apart, print a cleaning page. If this does not solve the problem, use the repetitive
defects ruler in this document to identify the cause of the problem.

Print the Supplies Status page
The Supplies status page indicates the estimated life remaining in print cartridges. It also lists the part
number for the correct genuine HP print cartridge for your product so you can order a replacement print
cartridge, as well as other useful information.

1. On the product control panel, open the Reports menu.

2. Select the Supplies status page to print it.
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Interpret the Print Quality Page
1. On the product control panel, open the Reports menu.

2. Select the Print Quality Page item to print it.

This page contains five bands of color, which are divided into four groups as indicated in the following
illustration. By examining each group, you can isolate the problem to a particular print cartridge.

Section Print-cartridge

1 Yellow

2 Cyan

3 Black

4 Magenta

● If dots or streaks appear in only one of the groups, replace the print cartridge that correlates with
that group.

● If dots appear in more than one group, print a cleaning page. If this does not solve the problem,
determine if the dots are always the same color; for example, if magenta dots appear in all five
color bands. If the dots are all the same color, replace that print cartridge.

● If streaks appear in multiple color bands, contact HP. A component other than the print cartridge
is probably causing the problem.

Inspect the print cartridge for damage
1. Remove the print cartridge from the product, and verify that the sealing tape has been removed.

2. Check the memory chip for damage.
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3. Examine the surface of the green imaging drum on the bottom of the print cartridge.

CAUTION: Do not touch the green roller (imaging drum) on the bottom of the cartridge.
Fingerprints on the imaging drum can cause print-quality problems.

4. If you see any scratches, fingerprints, or other damage on the imaging drum, replace the print
cartridge.

5. If the imaging drum does not appear to be damaged, rock the print cartridge gently several times
and reinstall it. Print a few pages to see if the problem has resolved.

Repeating defects
If defects repeat at any of the following intervals on the page, a print cartridge might be damaged.

● 22 mm

● 27 mm

● 29 mm

● 76 mm

Use the printer driver that best meets your printing needs
You might need to use a different printer driver if the printed page has unexpected lines in graphics,
missing text, missing graphics, incorrect formatting, or substituted fonts.

HP PCL 6 driver ● Provided as the default driver. This driver is automatically installed unless you
select a different one.

● Recommended for all Windows environments

● Provides the overall best speed, print quality, and product-feature support for
most users

● Developed to align with the Windows Graphic Device Interface (GDI) for the
best speed in Windows environments

● Might not be fully compatible with third-party and custom software programs
that are based on PCL 5
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HP UPD PS driver ● Recommended for printing with Adobe® software programs or with other highly
graphics-intensive software programs

● Provides support for printing from postscript emulation needs, or for postscript
flash font support

HP UPD PCL 5 ● Recommended for general office printing in Windows environments

● Compatible with previous PCL versions and older HP LaserJet products

● The best choice for printing from third-party or custom software programs

● The best choice when operating with mixed environments, which require the
product to be set to PCL 5 (UNIX, Linux, mainframe)

● Designed for use in corporate Windows environments to provide a single driver
for use with multiple printer models

● Preferred when printing to multiple printer models from a mobile Windows
computer

Download additional printer drivers from this Web site: www.hp.com/support/ljcp1520series.
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The product does not print or it prints slowly
The product does not print

If the product does not print at all, try the following solutions.

1. Make sure the product is turned on and that the control panel indicates it is ready.

◦ If the control panel does not indicate the product is ready, turn the product off and then on
again.

◦ If the control panel indicates the product is ready, try sending the job again.

2. If the control panel indicates the product has an error, resolve the error and then try sending the
job again.

3. Make sure the cables are all connected correctly. If the product is connected to a network, check
the following items:

◦ Check the light next to the network connection on the product. If the network is active, the
light is green.

◦ Make sure that you are using a network cable and not a phone cord to connect to the network.

◦ Make sure the network router, hub, or switch is turned on and that it is working correctly.

4. Install the HP software from the CD that came with the product. Using generic printer drivers can
cause delays clearing jobs from the print queue.

5. From the list of printers on your computer, right-click the name of this product, click Properties,
and open the Ports tab.

◦ If you are using a network cable to connect to the network, make sure the printer name listed
on the Ports tab matches the product name on the product configuration page.

◦ If you are using a USB cable and are connecting to a wireless network, make sure the box is
checked next to Virtual printer port for USB.

6. If you are using a personal firewall system on the computer, it might be blocking communication
with the product. Try temporarily disabling the firewall to see if it is the source of the problem.

7. If your computer or the product is connected to a wireless network, low signal quality or interference
might be delaying print jobs.

The product prints slowly
If the product prints, but it seems slow, try the following solutions.

1. Make sure the computer meets the minimum specifications for this product. For a list of
specifications, go to this Web site: www.hp.com/support/ljcp1520series.

2. When you configure the product to print on some paper types, such as heavy paper, the product
prints more slowly so it can correctly fuse the toner to the paper. If the paper type setting is not
correct for the type of paper you are using, change the setting to the correct paper type.

3. If your computer or the product is connected to a wireless network, low signal quality or interference
might be delaying print jobs.
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Solve connectivity problems 
Solve direct-connect problems

If you have connected the product directly to a computer, check the cable.

● Verify that the cable is connected to the computer and to the product.

● Verify that the cable is not longer than 5 m (16.4 ft). Try using a shorter cable.

● Verify that the cable is working correctly by connecting it to another product. Replace the cable if
necessary.

Solve network problems
Check the following items to verify that the product is communicating with the network. Before beginning,
print a configuration page from the product control panel and locate the product IP address that is listed
on this page.

● Poor physical connection

● The computer is using the incorrect IP address for the product

● The computer is unable to communicate with the product

● The product is using incorrect link and duplex settings for the network

● New software programs might be causing compatibility problems

● The computer or workstation might be set up incorrectly

● The product is disabled, or other network settings are incorrect

Poor physical connection
1. Verify that the product is attached to the correct network port using a cable of the correct length.

2. Verify that cable connections are secure.

3. Look at the network port connection on the back of the product, and verify that the amber activity
light and the green link-status light are lit.

4. If the problem continues, try a different cable or port on the hub.

The computer is using the incorrect IP address for the product
1. Open the printer properties and click the Ports tab. Verify that the current IP address for the product

is selected. The product IP address is listed on the product configuration page.

2. If you installed the product using the HP standard TCP/IP port, select the box labeled Always print
to this printer, even if its IP address changes.

3. If you installed the product using a Microsoft standard TCP/IP port, use the hostname instead of
the IP address.

4. If the IP address is correct, delete the product and then add it again.
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The computer is unable to communicate with the product
1. Test network communication by pinging the network.

a. Open a command-line prompt on your computer. For Windows, click Start, click Run, and
then type cmd.

b. Type ping followed by the IP address for your product.

c. If the window displays round-trip times, the network is working.

2. If the ping command failed, verify that the network hubs are on, and then verify that the network
settings, the product, and the computer are all configured for the same network.

The product is using incorrect link and duplex settings for the network
Hewlett-Packard recommends leaving this setting in automatic mode (the default setting). If you change
these settings, you must also change them for your network.

New software programs might be causing compatibility problems
Verify that any new software programs are correctly installed and that they use the correct printer driver.

The computer or workstation might be set up incorrectly
1. Check the network drivers, printer drivers, and the network redirection.

2. Verify that the operating system is configured correctly.

The product is disabled, or other network settings are incorrect
1. Review the configuration page to check the status of the network protocol. Enable it if necessary.

2. Reconfigure the network settings if necessary.

142 Chapter 10   Solve problems ENWW



Solve wireless network problems
● Wireless connectivity checklist

● The control panel displays the message: The wireless feature on this product has been turned off

● The product does not print after the wireless configuration completes

● The product does not print, and the computer has a third-party firewall installed

● The wireless connection does not work after moving the wireless router or product

● Cannot connect more computers to the wireless product

● The wireless product loses communication when connected to a VPN

● The network does not appear in the wireless networks list

● The wireless network is not functioning

Wireless connectivity checklist
● The product and the wireless router are turned on and have power. Also make sure the wireless

radio in the product is turned on.

● The service set identifier (SSID) is correct. Print a configuration page to determine the SSID. If you
are not sure the SSID is correct, run the wireless setup again.

● With secured networks, make sure the security information is correct. If the security information is
incorrect, run the wireless setup again.

● If the wireless network is working correctly, try accessing other computers on the wireless network.
If the network has Internet access, try connecting to the Internet over a wireless connection.

● The encryption method (AES or TKIP) is the same for the product as it is for the wireless access
point (on networks using WPA security).

● The product is within the range of the wireless network. For most networks, the product must be
within 30 m (100 ft) of the wireless access point (wireless router).

● Obstacles do not block the wireless signal. Remove any large metal objects between the access
point and the product. Make sure poles, walls, or support columns containing metal or concrete do
not separate the product and wireless access point.

● The product is located away from electronic devices that might interfere with the wireless signal.
Many devices can interfere with the wireless signal including motors, cordless phones, security
system cameras, other wireless networks, and some Bluetooth devices.

● The printer driver is installed on the computer.

● You have selected the correct printer port.

● The computer and product connect to the same wireless network.

ENWW Solve wireless network problems 143



The control panel displays the message: The wireless feature on this
product has been turned off

� Press the wireless button on the product to open the Wireless menu, and then turn the wireless
radio on.

The product does not print after the wireless configuration completes
1. Make sure the product is turned on and in the ready state.

2. Make sure you are connecting to the correct wireless network.

3. Make sure that the wireless network is working correctly.

a. Open the Network configuration menu, and then open the Wireless Menu item.

b. Select the Run Network Test item to test the wireless network. The product prints a report
with the results.

4. Make sure that the correct port or product is selected.

a. From the list of printers on your computer, right-click the name of this product, click
Properties, and then open the Ports tab.

b. Make sure the box is checked next to Virtual printer port for USB.

5. Make sure that your computer is working correctly. If necessary, restart your computer.

The product does not print, and the computer has a third-party firewall
installed

1. Update the firewall with the most recent update available from the manufacturer.

2. If programs request firewall access when you install the product or try to print, make sure you allow
the programs to run.

3. Temporarily turn off the firewall, and then install the wireless product on the computer. Enable the
firewall when you have completed the wireless installation.

The wireless connection does not work after moving the wireless router or
product

Make sure that the router or product connects to the same network that your computer connects to.

1. Open the Reports menu, and select the Configuration Report item to print the report.

2. Compare the service set identifier (SSID) on the configuration report to the SSID in the printer
configuration for your computer.

3. If the SSIDs are not the same, the devices are not connecting to the same network. Reconfigure
the wireless setup for your product.
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Cannot connect more computers to the wireless product
1. Make sure that the other computers are within the wireless range and that no obstacles block the

signal. For most networks, the wireless range is within 30 m (100 ft) of the wireless access point.

2. Make sure the product is turned on and in the ready state.

3. Turn off any third-party firewalls on your computer.

4. Make sure that the wireless network is working correctly.

a. On the product control panel, open the Network configuration menu, and then open the
Wireless Menu item.

b. Select the Run Network Test item to test the wireless network. The product prints a report
with the results.

5. Make sure that the correct port or product is selected.

a. From the list of printers on your computer, right-click the name of this product, click
Properties, and then open the Ports tab.

b. Click the Configure Port button to verify that the IP address matches the IP address listed
on the Run Network Test report.

6. Make sure that your computer is working correctly. If necessary, restart your computer.

The wireless product loses communication when connected to a VPN
● Typically, you cannot connect to a VPN and other networks at the same time.

The network does not appear in the wireless networks list
● Make sure the wireless router is turned on and has power.

● The network might be hidden. However, you can still connect to a hidden network.
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The wireless network is not functioning
1. To verify if the network has lost communication, try connecting other devices to the network.

2. Test network communication by pinging the network.

a. Open a command-line prompt on your computer. For Windows, click Start, click Run, and
then type cmd.

b. Type ping followed by the service set identifier (SSID) for your network.

c. If the window displays round-trip times, the network is working.

3. Make sure that the router or product connects to the same network that your computer connects
to.

a. Open the Reports menu, and select the Configuration Report item to print the report.

b. Compare the service set identifier (SSID) on the configuration report to the SSID in the printer
configuration for your computer.

c. If the SSIDs are not the same, the devices are not connecting to the same network.
Reconfigure the wireless setup for your product.
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Solve product software problems
Product software problems

Problem Solution

A printer driver for the product is not visible in the Printer folder ● Restart the computer to restart the spooler process. If the
spooler has crashed, no printer drivers will appear in the
Printers folder.

● Reinstall the product software.

NOTE: Close any applications that are running. To
close an application that has an icon in the system tray,
right-click the icon, and select Close or Disable.

● Try plugging the USB cable into a different USB port on
the computer.

An error message was displayed during the software
installation

● Reinstall the product software.

NOTE: Close any applications that are running. To
close an application that has an icon in the task bar, right-
click the icon, and select Close or Disable.

● Check the amount of free space on the drive where you
are installing the product software. If necessary, free up
as much space as you can, and reinstall the product
software.

● If necessary, run the Disk Defragmenter, and reinstall the
product software.

The product is in Ready mode, but nothing prints ● Print a Configuration page, and verify the product
functionality.

● Verify that all of the cables are correctly seated and within
specifications. This includes the USB and power cables.
Try a new cable.
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Solve common Mac problems
● The printer driver is not listed in the Print & Fax list

● The product name does not appear in the product list in the Print & Fax list

● The printer driver does not automatically set up the selected product in the Print & Fax list

● A print job was not sent to the product that you wanted

● When connected with a USB cable, the product does not appear in the Print & Fax list after the
driver is selected.

● You are using a generic printer driver when using a USB connection

The printer driver is not listed in the Print & Fax list
1. Make sure that the product .GZ file is in the following hard-drive folder: Library/Printers/

PPDs/Contents/Resources. If necessary, reinstall the software.

2. If the GZ file is in the folder, the PPD file might be corrupt. Delete the file and then reinstall the
software.

The product name does not appear in the product list in the Print & Fax list
1. Make sure that the cables are connected correctly and the product is on.

2. Print a configuration page to check the product name. Verify that the name on the configuration
page matches the product name in the Print & Fax list.

3. Replace the USB or network cable with a high-quality cable.

The printer driver does not automatically set up the selected product in the Print & Fax
list

1. Make sure that the cables are connected correctly and the product is on.

2. Make sure that the product .GZ file is in the following hard-drive folder: Library/Printers/
PPDs/Contents/Resources. If necessary, reinstall the software.

3. If the GZ file is in the folder, the PPD file might be corrupt. Delete the file and then reinstall the
software.

4. Replace the USB or network cable with a high-quality cable.

A print job was not sent to the product that you wanted
1. Open the print queue and restart the print job.

2. Another product with the same or similar name might have received your print job. Print a
configuration page to check the product name. Verify that the name on the configuration page
matches the product name in the Print & Fax list.
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When connected with a USB cable, the product does not appear in the Print & Fax list
after the driver is selected.

Software troubleshooting

� Make sure that your Mac operating system is Mac OS X 10.5 or later.

Hardware troubleshooting

1. Make sure that the product is turned on.

2. Make sure that the USB cable is connected correctly.

3. Make sure that you are using the appropriate high-speed USB cable.

4. Make sure that you do not have too many USB devices drawing power from the chain. Disconnect
all of the devices from the chain, and connect the cable directly to the USB port on the computer

5. Check to see if more than two non-powered USB hubs are connected in a row on the chain.
Disconnect all of the devices from the chain, and then connect the cable directly to the USB port
on the computer.

NOTE: The iMac keyboard is a non-powered USB hub.

You are using a generic printer driver when using a USB connection
If you connected the USB cable before you installed the software, you might be using a generic printer
driver instead of the driver for this product.

1. Delete the generic printer driver.

2. Reinstall the software from the product CD. Do not connect the USB cable until the software
installation program prompts you.

3. If multiple printers are installed, make sure that you have selected the correct printer in the Format
For drop-down menu in the Print dialog box.
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A Supplies and accessories

● Order parts, accessories, and supplies

● Part numbers
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Order parts, accessories, and supplies
Order supplies and paper www.hp.com/go/suresupply

Order genuine HP parts or accessories www.hp.com/buy/parts

Order through service or support providers Contact an HP-authorized service or support provider.

Part numbers

Print cartridges
Table A-1  Print cartridges

Part Part number Type/size

Print cartridges CE320A Black print cartridge with HP ColorSphere toner

CE321A Cyan print cartridge with HP ColorSphere toner

CE322A Yellow print cartridge with HP ColorSphere toner

CE323A Magenta print cartridge with HP ColorSphere toner

NOTE: For information about the yield for the cartridges, see www.hp.com/go/pageyield. Actual yield
depends on specific use.

Cables and interfaces

Item Description Part number

USB cable 2-meter A-to-B cable 8121-0868
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B Service and support

● Hewlett-Packard limited warranty statement

● HP's Premium Protection Warranty: LaserJet print cartridge limited warranty statement

● Data stored on the print cartridge

● End User License Agreement

● OpenSSL

● Customer support

● Repack the product
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Hewlett-Packard limited warranty statement
HP PRODUCT DURATION OF LIMITED WARRANTY

HP Color LaserJet CP1525n, CP1525nw One-year product exchange

HP warrants to you, the end-user customer, that HP hardware and accessories will be free from defects
in materials and workmanship after the date of purchase, for the period specified above. If HP receives
notice of such defects during the warranty period, HP will, at its option, either repair or replace products
which prove to be defective. Replacement products may be either new or equivalent in performance to
new.

HP warrants to you that HP software will not fail to execute its programming instructions after the date
of purchase, for the period specified above, due to defects in material and workmanship when properly
installed and used. If HP receives notice of such defects during the warranty period, HP will replace
software which does not execute its programming instructions due to such defects.

HP does not warrant that the operation of HP products will be uninterrupted or error free. If HP is unable,
within a reasonable time, to repair or replace any product to a condition as warranted, you will be entitled
to a refund of the purchase price upon prompt return of the product.

HP products may contain remanufactured parts equivalent to new in performance or may have been
subject to incidental use.

Warranty does not apply to defects resulting from (a) improper or inadequate maintenance or calibration,
(b) software, interfacing, parts or supplies not supplied by HP, (c) unauthorized modification or misuse,
(d) operation outside of the published environmental specifications for the product, or (e) improper site
preparation or maintenance.

TO THE EXTENT ALLOWED BY LOCAL LAW, THE ABOVE WARRANTIES ARE EXCLUSIVE AND
NO OTHER WARRANTY OR CONDITION, WHETHER WRITTEN OR ORAL, IS EXPRESSED OR
IMPLIED AND HP SPECIFICALLY DISCLAIMS ANY IMPLIED WARRANTIES OR CONDITIONS OF
MERCHANTABILITY, SATISFACTORY QUALITY, AND FITNESS FOR A PARTICULAR PURPOSE.
Some countries/regions, states or provinces do not allow limitations on the duration of an implied
warranty, so the above limitation or exclusion might not apply to you. This warranty gives you specific
legal rights and you might also have other rights that vary from country/region to country/region, state
to state, or province to province.

HP's limited warranty is valid in any country/region or locality where HP has a support presence for this
product and where HP has marketed this product. The level of warranty service you receive may vary
according to local standards. HP will not alter form, fit or function of the product to make it operate in a
country/region for which it was never intended to function for legal or regulatory reasons.

TO THE EXTENT ALLOWED BY LOCAL LAW, THE REMEDIES IN THIS WARRANTY STATEMENT
ARE YOUR SOLE AND EXCLUSIVE REMEDIES. EXCEPT AS INDICATED ABOVE, IN NO EVENT
WILL HP OR ITS SUPPLIERS BE LIABLE FOR LOSS OF DATA OR FOR DIRECT, SPECIAL,
INCIDENTAL, CONSEQUENTIAL (INCLUDING LOST PROFIT OR DATA), OR OTHER DAMAGE,
WHETHER BASED IN CONTRACT, TORT, OR OTHERWISE. Some countries/regions, states or
provinces do not allow the exclusion or limitation of incidental or consequential damages, so the above
limitation or exclusion may not apply to you.

THE WARRANTY TERMS CONTAINED IN THIS STATEMENT, EXCEPT TO THE EXTENT
LAWFULLY PERMITTED, DO NOT EXCLUDE, RESTRICT OR MODIFY AND ARE IN ADDITION TO
THE MANDATORY STATUTORY RIGHTS APPLICABLE TO THE SALE OF THIS PRODUCT TO YOU.
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HP's Premium Protection Warranty: LaserJet print
cartridge limited warranty statement

This HP product is warranted to be free from defects in materials and workmanship.

This warranty does not apply to products that (a) have been refilled, refurbished, remanufactured or
tampered with in any way, (b) experience problems resulting from misuse, improper storage, or
operation outside of the published environmental specifications for the printer product or (c) exhibit wear
from ordinary use.

To obtain warranty service, please return the product to place of purchase (with a written description of
the problem and print samples) or contact HP customer support. At HP's option, HP will either replace
products that prove to be defective or refund your purchase price.

TO THE EXTENT ALLOWED BY LOCAL LAW, THE ABOVE WARRANTY IS EXCLUSIVE AND NO
OTHER WARRANTY OR CONDITION, WHETHER WRITTEN OR ORAL, IS EXPRESSED OR
IMPLIED AND HP SPECIFICALLY DISCLAIMS ANY IMPLIED WARRANTIES OR CONDITIONS OF
MERCHANTABILITY, SATISFACTORY QUALITY, AND FITNESS FOR A PARTICULAR PURPOSE.

TO THE EXTENT ALLOWED BY LOCAL LAW, IN NO EVENT WILL HP OR ITS SUPPLIERS BE
LIABLE FOR DIRECT, SPECIAL, INCIDENTAL, CONSEQUENTIAL (INCLUDING LOST PROFIT OR
DATA), OR OTHER DAMAGE, WHETHER BASED IN CONTRACT, TORT, OR OTHERWISE.

THE WARRANTY TERMS CONTAINED IN THIS STATEMENT, EXCEPT TO THE EXTENT
LAWFULLY PERMITTED, DO NOT EXCLUDE, RESTRICT OR MODIFY AND ARE IN ADDITION TO
THE MANDATORY STATUTORY RIGHTS APPLICABLE TO THE SALE OF THIS PRODUCT TO YOU.
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Data stored on the print cartridge
The HP print cartridges used with this product contain a memory chip that assists in the operation of the
product.

In addition, this memory chip collects a limited set of information about the usage of the product, which
might include the following: the date when the print cartridge was first installed, the date when the print
cartridge was last used, the number of pages printed using the print cartridge, the page coverage, the
printing modes used, any printing errors that might have occurred, and the product model. This
information helps HP design future products to meet our customers' printing needs.

The data collected from the print cartridge memory chip does not contain information that can be used
to identify a customer or user of the print cartridge or their product.

HP collects a sampling of the memory chips from print cartridges returned to HP's free return and
recycling program (HP Planet Partners: www.hp.com/recycle). The memory chips from this sampling
are read and studied in order to improve future HP products. HP partners who assist in recycling this
print cartridge might have access to this data, as well.

Any third party possessing the print cartridge might have access to the anonymous information on the
memory chip. If you prefer to not allow access to this information, you can render the chip inoperable.
However, after you render the memory chip inoperable, the memory chip cannot be used in an HP
product.
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End User License Agreement
PLEASE READ CAREFULLY BEFORE USING THIS SOFTWARE PRODUCT: This End-User License
Agreement (“EULA”) is a contract between (a) you (either an individual or the entity you represent) and
(b) Hewlett-Packard Company (“HP”) that governs your use of the software product (“Software”). This
EULA does not apply if there is a separate license agreement between you and HP or its suppliers for
the Software, including a license agreement in online documentation. The term “Software” may include
(i) associated media, (ii) a user guide and other printed materials, and (iii) “online” or electronic
documentation (collectively “User Documentation”).

RIGHTS IN THE SOFTWARE ARE OFFERED ONLY ON THE CONDITION THAT YOU AGREE TO
ALL TERMS AND CONDITIONS OF THIS EULA. BY INSTALLING, COPYING, DOWNLOADING, OR
OTHERWISE USING THE SOFTWARE, YOU AGREE TO BE BOUND BY THIS EULA. IF YOU DO
NOT ACCEPT THIS EULA, DO NOT INSTALL, DOWNLOAD, OR OTHERWISE USE THE
SOFTWARE. IF YOU PURCHASED THE SOFTWARE BUT DO NOT AGREE TO THIS EULA, PLEASE
RETURN THE SOFTWARE TO YOUR PLACE OF PURCHASE WITHIN FOURTEEN DAYS FOR A
REFUND OF THE PURCHASE PRICE; IF THE SOFTWARE IS INSTALLED ON OR MADE
AVAILABLE WITH ANOTHER HP PRODUCT, YOU MAY RETURN THE ENTIRE UNUSED
PRODUCT.

1. THIRD PARTY SOFTWARE. The Software may include, in addition to HP proprietary software
(“HP Software”), software under licenses from third parties (“Third Party Software” and “Third Party
License”). Any Third Party Software is licensed to you subject to the terms and conditions of the
corresponding Third Party License. Generally, the Third Party License is located in a file such as
license.txt; you should contact HP support if you cannot find any Third Party License. If the Third Party
Licenses include licenses that provide for the availability of source code (such as the GNU General
Public License) and the corresponding source code is not included with the Software, then check the
product support pages of HP’s website (hp.com) to learn how to obtain such source code.

2. LICENSE RIGHTS. You will have the following rights provided you comply with all terms and
conditions of this EULA:

a. Use. HP grants you a license to Use one copy of the HP Software. “Use” means installing, copying,
storing, loading, executing, displaying, or otherwise using the HP Software. You may not modify the
HP Software or disable any licensing or control feature of the HP Software. If this Software is provided
by HP for Use with an imaging or printing product (for example, if the Software is a printer driver,
firmware, or add-on), the HP Software may only be used with such product (“HP Product”). Additional
restrictions on Use may appear in the User Documentation. You may not separate component parts of
the HP Software for Use. You do not have the right to distribute the HP Software.

b. Copying. Your right to copy means you may make archival or back-up copies of the HP Software,
provided each copy contains all the original HP Software’s proprietary notices and is used only for back-
up purposes.

3. UPGRADES. To Use HP Software provided by HP as an upgrade, update, or supplement (collectively
“Upgrade”), you must first be licensed for the original HP Software identified by HP as eligible for the
Upgrade. To the extent the Upgrade supersedes the original HP Software, you may no longer use such
HP Software. This EULA applies to each Upgrade unless HP provides other terms with the Upgrade. In
case of a conflict between this EULA and such other terms, the other terms will prevail.

4. TRANSFER.

a. Third Party Transfer. The initial end user of the HP Software may make a one-time transfer of the
HP Software to another end user. Any transfer will include all component parts, media, User
Documentation, this EULA, and if applicable, the Certificate of Authenticity. The transfer may not be an
indirect transfer, such as a consignment. Prior to the transfer, the end user receiving the transferred
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Software will agree to this EULA. Upon transfer of the HP Software, your license is automatically
terminated.

b. Restrictions. You may not rent, lease or lend the HP Software or Use the HP Software for commercial
timesharing or bureau use. You may not sublicense, assign or otherwise transfer the HP Software except
as expressly provided in this EULA.

5. PROPRIETARY RIGHTS. All intellectual property rights in the Software and User Documentation are
owned by HP or its suppliers and are protected by law, including applicable copyright, trade secret,
patent, and trademark laws. You will not remove any product identification, copyright notice, or
proprietary restriction from the Software.

6. LIMITATION ON REVERSE ENGINEERING. You may not reverse engineer, decompile, or
disassemble the HP Software, except and only to the extent that the right to do so is allowed under
applicable law.

7. CONSENT TO USE OF DATA. HP and its affiliates may collect and use technical information you
provide in relation to (i) your Use of the Software or the HP Product, or (ii) the provision of support
services related to the Software or the HP Product. All such information will be subject to HP’s privacy
policy. HP will not use such information in a form that personally identifies you except to the extent
necessary to enhance your Use or provide support services.

8. LIMITATION OF LIABILITY. Notwithstanding any damages that you might incur, the entire liability of
HP and its suppliers under this EULA and your exclusive remedy under this EULA will be limited to the
greater of the amount actually paid by you for the Product or U.S. $5.00. TO THE MAXIMUM EXTENT
PERMITTED BY APPLICABLE LAW, IN NO EVENT WILL HP OR ITS SUPPLIERS BE LIABLE FOR
ANY SPECIAL, INCIDENTAL, INDIRECT, OR CONSEQUENTIAL DAMAGES (INCLUDING
DAMAGES FOR LOST PROFITS, LOST DATA, BUSINESS INTERRUPTION, PERSONAL INJURY,
OR LOSS OF PRIVACY) RELATED IN ANY WAY TO THE USE OF OR INABILITY TO USE THE
SOFTWARE, EVEN IF HP OR ANY SUPPLIER HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH
DAMAGES AND EVEN IF THE ABOVE REMEDY FAILS OF ITS ESSENTIAL PURPOSE. Some states
or other jurisdictions do not allow the exclusion or limitation of incidental or consequential damages, so
the above limitation or exclusion may not apply to you.

9. U.S. GOVERNMENT CUSTOMERS. If you are a U.S. Government entity, then consistent with FAR
12.211 and FAR 12.212, Commercial Computer Software, Computer Software Documentation, and
Technical Data for Commercial Items are licensed under the applicable HP commercial license
agreement.

10. COMPLIANCE WITH EXPORT LAWS. You will comply with all laws, rules, and regulations (i)
applicable to the export or import of the Software, or (ii) restricting the Use of the Software, including
any restrictions on nuclear, chemical, or biological weapons proliferation.

11. RESERVATION OF RIGHTS. HP and its suppliers reserve all rights not expressly granted to you
in this EULA.

(c) 2007 Hewlett-Packard Development Company, L.P.

Rev. 11/06
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OpenSSL
This product includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit (http://
www.openssl.org/)

THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT ``AS IS'' AND ANY EXPRESSED OR
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO
EVENT SHALL THE OpenSSL PROJECT OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT,
INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING,
BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;

LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND
ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This product includes cryptographic software written by Eric Young (eay@cryptsoft.com). This product
includes software written by Tim Hudson (tjh@cryptsoft.com).
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Customer support
Get telephone support for your country/region

Have the product name, serial number, date of purchase, and
problem description ready.

Country/region phone numbers are on the flyer that was in the
box with your product or at www.hp.com/support/.

Get 24-hour Internet support www.hp.com/support/ljcp1520series

Get support for products used with a Macintosh computer www.hp.com/go/macosx

Download software utilities, drivers, and electronic information www.hp.com/support/ljcp1520series

Order additional HP service or maintenance agreements www.hp.com/go/carepack

Register your product www.register.hp.com
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Repack the product
If HP Customer Care determines that your product needs to be returned to HP for repair, follow these
steps to repack the product before shipping it.

CAUTION: Shipping damage as a result of inadequate packing is the customer’s responsibility.

1. Remove and retain the print cartridges.

CAUTION: It is extremely important to remove the print cartridges before shipping the product.
A print cartridge that remains in the product during shipping can leak and cover the product engine
and other parts with toner.

To prevent damage to the print cartridges, avoid touching the rollers on them, and store the print
cartridges so that they are not exposed to light.

2. Remove and retain the power cable, interface cable, and any optional accessories.

3. If possible, include print samples and 50 to 100 sheets of paper that did not print correctly.

4. In the U.S., call HP Customer Care to request new packing material. In other areas, use the original
packing material, if possible.
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C Product specifications

● Physical specifications

● Power consumption, electrical specifications, and acoustic emissions

● Environmental specifications
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Physical specifications
Table C-1  Physical specifications

Height Depth Width Weight

254 mm (10.0 inches) 452 mm (17.8 inches) 399 mm (15.7 inches) 18.43 kg (40.64 lb)

Power consumption, electrical specifications, and
acoustic emissions

See www.hp.com/support/ljcp1520series for current information.

CAUTION: Power requirements are based on the country/region where the product is sold. Do not
convert operating voltages. This will damage the product and void the product warranty.

Environmental specifications
Table C-2  Operating-environment specifications

Environment Recommended Allowed

Temperature 17° to 25°C (62.6° to 77°F) 15° to 30°C (59° to 86°F)

Humidity 30% to 70% relative humidity (RH) 10% to 80% RH

Altitude Not applicable 0 to 3048 m (0 to 10,000 ft)
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D Regulatory information

● FCC regulations

● Environmental product stewardship program

● Declaration of conformity

● Declaration of Conformity (wireless models)

● Safety statements

● Additional statements for wireless products
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FCC regulations
This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant
to Part 15 of the FCC rules. These limits are designed to provide reasonable protection against harmful
interference in a residential installation. This equipment generates, uses, and can radiate radio
frequency energy. If this equipment is not installed and used in accordance with the instructions, it may
cause harmful interference to radio communications. However, there is no guarantee that interference
will not occur in a particular installation. If this equipment does cause harmful interference to radio or
television reception, which can be determined by turning the equipment off and on, the user is
encouraged to try to correct the interference by one or more of the following measures:

● Reorient or relocate the receiving antenna.

● Increase separation between equipment and receiver.

● Connect equipment to an outlet on a circuit different from that to which the receiver is located.

● Consult your dealer or an experienced radio/TV technician.

NOTE: Any changes or modifications to the printer that are not expressly approved by HP could void
the user’s authority to operate this equipment.

Use of a shielded interface cable is required to comply with the Class B limits of Part 15 of FCC rules.
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Environmental product stewardship program
Protecting the environment

Hewlett-Packard Company is committed to providing quality products in an environmentally sound
manner. This product has been designed with several attributes to minimize impacts on our environment.

Ozone production
This product generates no appreciable ozone gas (O3).

Power consumption
Power usage drops significantly while in Ready or Sleep mode, which saves natural resources and
saves money without affecting the high performance of this product. Hewlett-Packard printing and
imaging equipment marked with the ENERGY STAR® logo is qualified to the U.S. Environmental
Protection Agency's ENERGY STAR specifications for imaging equipment. The following mark will
appear on ENERGY STAR qualified imaging products:

Additional ENERGY STAR qualified imaging product model information is listed at:

www.hp.com/go/energystar

Paper use
This product’s manual duplex feature (two-sided printing) and N-up printing (multiple pages printed on
one page) capability can reduce paper usage and the resulting demands on natural resources.

Plastics
Plastic parts over 25 grams are marked according to international standards that enhance the ability to
identify plastics for recycling purposes at the end of the product’s life.

HP LaserJet print supplies
It’s easy to return and recycle your HP LaserJet print cartridges after use—free of charge—with
HP Planet Partners. Multilingual program information and instructions are included in every new
HP LaserJet print cartridge and supplies package. You help reduce the toll on the environment further
when you return multiple cartridges together rather than separately.

HP is committed to providing inventive, high-quality products and services that are environmentally
sound, from product design and manufacturing to distribution, customer use and recycling. When you
participate in the HP Planet Partners program, we ensure your HP LaserJet print cartridges are recycled
properly, processing them to recover plastics and metals for new products and diverting millions of tons
of waste from landfills. Since this cartridge is being recycled and used in new materials, it will not be
returned to you. Thank you for being environmentally responsible!
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NOTE: Use the return label to return original HP LaserJet print cartridges only. Please do not use this
label for HP inkjet cartridges, non-HP cartridges, refilled or remanufactured cartridges or warranty
returns. For information about recycling your HP inkjet cartridges please go to http://www.hp.com/
recycle.

Return and recycling instructions

United States and Puerto Rico
The enclosed label in the HP LaserJet toner cartridge box is for the return and recycling of one or more
HP LaserJet print cartridges after use. Please follow the applicable instructions below.

Multiple returns (more than one cartridge)

1. Package each HP LaserJet print cartridge in its original box and bag.

2. Tape the boxes together using strapping or packaging tape. The package can weigh up to 31 kg
(70 lb).

3. Use a single pre-paid shipping label.

OR

1. Use your own suitable box, or request a free bulk collection box from www.hp.com/recycle or
1-800-340-2445 (holds up to 31 kg (70 lb) of HP LaserJet print cartridges).

2. Use a single pre-paid shipping label.

Single returns

1. Package the HP LaserJet print cartridge in its original bag and box.

2. Place the shipping label on the front of the box.

Shipping

For all HP LaserJet print cartridge recycling returns, give the package to UPS during your next delivery
or pickup, or take it to an authorized UPS drop-off center. For the location of your local UPS drop-off
center, call 1-800-PICKUPS or visit www.ups.com. If you are returning via USPS label, give the package
to a U.S. Postal Service carrier or drop off at a U.S. Postal Service Office. For more information, or to
order additional labels or boxes for bulk returns, visit www.hp.com/recycle or call 1-800-340-2445.
Requested UPS pickup will be charged normal pickup rates. Information subject to change without
notice.

Residents of Alaska and Hawaii

Do not use the UPS label. Call 1-800-340-2445 for information and instructions. The U.S. Postal Service
provides no-cost cartridge return transportation services under an arrangement with HP for Alaska and
Hawaii.

Non-U.S. returns
To participate in HP Planet Partners return and recycling program, just follow the simple directions in
the recycling guide (found inside the packaging of your new product supply item) or visit www.hp.com/
recycle. Select your country/region for information on how to return your HP LaserJet printing supplies.
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Paper
This product is capable of using recycled papers when the paper meets the guidelines outlined in the
HP LaserJet Printer Family Print Media Guide. This product is suitable for the use of recycled paper
according to EN12281:2002.

Material restrictions
This HP product contains mercury in the fluorescent lamp of the scanner and/or control panel liquid
crystal display that may require special handling at end-of-life.

This HP product does not contain a battery.

For recycling information, you can go to www.hp.com/recycle, or contact your local authorities or the
Electronics Industries Alliance: www.eiae.org.

Disposal of waste equipment by users in private households in the
European Union

This symbol on the product or on its packaging indicates that this product must not be disposed of with
your other household waste. Instead, it is your responsibility to dispose of your waste equipment by
handing it over to a designated collection point for the recycling of waste electrical and electronic
equipment. The separate collection and recycling of your waste equipment at the time of disposal will
help to conserve natural resources and ensure that it is recycled in a manner that protects human health
and the environment. For more information about where you can drop off your waste equipment for
recycling, please contact your local city office, your household waste disposal service or the shop where
you purchased the product.

Chemical substances
HP is committed to providing our customers with information about the chemical substances in our
products as needed to comply with legal requirements such as REACH (Regulation EC No 1907/2006
of the European Parliament and the Council). A chemical information report for this product can be found
at: www.hp.com/go/reach.

Material Safety Data Sheet (MSDS)
Material Safety Data Sheets (MSDS) for supplies containing chemical substances (for example, toner)
can be obtained by accessing the HP Web site at www.hp.com/go/msds or www.hp.com/hpinfo/
community/environment/productinfo/safety.
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For more information
To obtain information about these environmental topics:

● Product environmental profile sheet for this and many related HP products

● HP’s commitment to the environment

● HP’s environmental management system

● HP’s end-of-life product return and recycling program

● Material Safety Data Sheets

Visit www.hp.com/go/environment or www.hp.com/hpinfo/globalcitizenship/environment.
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Declaration of conformity
Declaration of Conformity

according to ISO/IEC 17050-1 and EN 17050-1

Manufacturer's Name: Hewlett-Packard Company DoC#: BOISB-0603–03–rel. 1.0

Manufacturer's Address: 11311 Chinden Boulevard

Boise, Idaho 83714-1021, USA

declares, that the product

Product Name: HP Color LaserJet CP1525n

Regulatory Model:2) BOISB-0603-03

Product Options: ALL

Print Cartridges: CE320A, CE321A, CE322A, CE323A

conforms to the following Product Specifications:

SAFETY: IEC 60950-1:2005 / EN60950-1: 2006

IEC 60825-1:2006 / EN 60825-1:2007 (Class 1 Laser/LED Product)

IEC 62311:2007 / EN62311:2008

GB4943-2001

EMC: CISPR22:2005 +A1/ EN55022:2006 +A1 - Class B1)

EN 61000-3-2:2006

EN 61000-3-3:1995 +A1 +A2

EN 55024:1998 +A1 +A2

FCC Title 47 CFR, Part 15 Class B / ICES-003, Issue 4

GB9254-2008, GB17625.1-2003

ENERGY USE: Regulation (EC) No. 1275/2008

Supplementary Information:

The product herewith complies with the requirements of the EMC Directive 2004/108/EC and the Low Voltage Directive 2006/95/EC, the
EuP Directive 2005/32/EC and carries the CE-Marking  accordingly.

This Device complies with Part 15 of the FCC Rules. Operation is subject to the following two Conditions: (1) this device may not cause
harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

1. The product was tested in a typical configuration with Hewlett-Packard Personal Computer Systems.

2. For regulatory purposes, these products are assigned a Regulatory model number. This number should not be confused with the product
name or the product number(s).

Boise, Idaho USA

September 2010

For Regulatory Topics only, contact:
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European Contact Your Local Hewlett-Packard Sales and Service Office or Hewlett-Packard GmbH, Department HQ-
TRE / Standards Europe, Herrenberger Strasse 140, D-71034, Böblingen (FAX: +49-7031-14-3143)
www.hp.com/go/certificates

USA Contact Product Regulations Manager, Hewlett-Packard Company, PO Box 15, Mail Stop 160, Boise, Idaho
83707-0015 (Phone: 208-396-6000)
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Declaration of Conformity (wireless models)
Declaration of Conformity

according to ISO/IEC 17050-1 and EN 17050-1

Manufacturer's Name: Hewlett-Packard Company DoC#: BOISB-0603–04–rel. 1.0

Manufacturer's Address: 11311 Chinden Boulevard

Boise, Idaho 83714-1021, USA

declares, that the product

Product Name: HP Color LaserJet CP1525nw

Regulatory Model:2) BOISB-0603-04

Product Options: ALL

Radio Module3) SDGOB-0892

Print Cartridges: CE320A, CE321A, CE322A, CE323A

conforms to the following Product Specifications:

SAFETY: IEC 60950-1:2005 / EN60950-1: 2006

IEC 60825-1:2006 / EN 60825-1:2007 (Class 1 Laser/LED Product)

IEC 62311:2007 / EN62311:2008

GB4943-2001

EMC: CISPR22:2005 +A1/ EN55022:2006 +A1 - Class B1)

EN 61000-3-2:2006

EN 61000-3-3:1995 +A1 +A2

EN 55024:1998 +A1 +A2

FCC Title 47 CFR, Part 15 Class B / ICES-003, Issue 4

GB9254-2008, GB17625.1-2003

Radio3) EN 301 489-1:V1.8.1 / EN 301 489-17:V1.3.2

EN 300 328:V1.7.1

FCC Title 47 CFR, Part 15 Subpart C (Section 15.247) / IC: RSS-210

ENERGY USE: Regulation (EC) No. 1275/2008

Supplementary Information:

The product herewith complies with the requirements of the EMC Directive 2004/108/EEC and the Low Voltage Directive 2006/95/EC, the
EuP Directive 2005/32/EC, and carries the CE-Marking  accordingly.
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This Device complies with Part 15 of the FCC Rules. Operation is subject to the following two Conditions: (1) this device may not cause
harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

1. The product was tested in a typical configuration with Hewlett-Packard Personal Computer Systems.

2. For regulatory purposes, these products are assigned a Regulatory model number. This number should not be confused with the product
name or the product number(s).

3. This product uses a radio module device which Regulatory Model number is SDGOB-0892 as needed to meet technical regulatory
requirements for the countries/regions this product will be sold.

Boise, Idaho USA

September 2010

For Regulatory Topics only, contact:

European Contact Your Local Hewlett-Packard Sales and Service Office or Hewlett-Packard GmbH, Department HQ-
TRE / Standards Europe, Herrenberger Strasse 140, D-71034, Böblingen (FAX: +49-7031-14-3143)
www.hp.com/go/certificates

USA Contact Product Regulations Manager, Hewlett-Packard Company, PO Box 15, Mail Stop 160, Boise, Idaho
83707-0015 (Phone: 208-396-6000)
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Safety statements
Laser safety

The Center for Devices and Radiological Health (CDRH) of the U.S. Food and Drug Administration has
implemented regulations for laser products manufactured since August 1, 1976. Compliance is
mandatory for products marketed in the United States. The device is certified as a “Class 1” laser product
under the U.S. Department of Health and Human Services (DHHS) Radiation Performance Standard
according to the Radiation Control for Health and Safety Act of 1968. Since radiation emitted inside the
device is completely confined within protective housings and external covers, the laser beam cannot
escape during any phase of normal user operation.

WARNING! Using controls, making adjustments, or performing procedures other than those specified
in this user guide may result in exposure to hazardous radiation.

Canadian DOC regulations
Complies with Canadian EMC Class B requirements.

« Conforme à la classe B des normes canadiennes de compatibilité électromagnétiques. « CEM ». »

VCCI statement (Japan)

Power cord instructions
Make sure your power source is adequate for the product voltage rating. The voltage rating is on the
product label. The product uses either 100-127 Vac or 220-240 Vac and 50/60 Hz.

Connect the power cord between the product and a grounded AC outlet.

CAUTION: To prevent damage to the product, use only the power cord that is provided with the
product.

Power cord statement (Japan)
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EMC statement (Korea)

Laser statement for Finland
Luokan 1 laserlaite

Klass 1 Laser Apparat

HP Color LaserJet CP1525n, CP1525nw, laserkirjoitin on käyttäjän kannalta turvallinen luokan 1
laserlaite. Normaalissa käytössä kirjoittimen suojakotelointi estää lasersäteen pääsyn laitteen
ulkopuolelle. Laitteen turvallisuusluokka on määritetty standardin EN 60825-1 (2007) mukaisesti.

VAROITUS !

Laitteen käyttäminen muulla kuin käyttöohjeessa mainitulla tavalla saattaa altistaa käyttäjän
turvallisuusluokan 1 ylittävälle näkymättömälle lasersäteilylle.

VARNING !

Om apparaten används på annat sätt än i bruksanvisning specificerats, kan användaren utsättas för
osynlig laserstrålning, som överskrider gränsen för laserklass 1.

HUOLTO

HP Color LaserJet CP1525n, CP1525nw - kirjoittimen sisällä ei ole käyttäjän huollettavissa olevia
kohteita. Laitteen saa avata ja huoltaa ainoastaan sen huoltamiseen koulutettu henkilö. Tällaiseksi
huoltotoimenpiteeksi ei katsota väriainekasetin vaihtamista, paperiradan puhdistusta tai muita käyttäjän
käsikirjassa lueteltuja, käyttäjän tehtäväksi tarkoitettuja ylläpitotoimia, jotka voidaan suorittaa ilman
erikoistyökaluja.

VARO !

Mikäli kirjoittimen suojakotelo avataan, olet alttiina näkymättömällelasersäteilylle laitteen ollessa
toiminnassa. Älä katso säteeseen.

VARNING !

Om laserprinterns skyddshölje öppnas då apparaten är i funktion, utsättas användaren för osynlig
laserstrålning. Betrakta ej strålen.

Tiedot laitteessa käytettävän laserdiodin säteilyominaisuuksista: Aallonpituus 775-795 nm Teho 5 m W
Luokan 3B laser.
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GS statement (Germany)
Das Gerät ist nicht für die Benutzung im unmittelbaren Gesichtsfeld am Bildschirmarbeitsplatz
vorgesehen. Um störende Reflexionen am Bildschirmarbeitsplatz zu vermeiden, darf dieses Produkt
nicht im unmittelbaren Gesichtsfeld platziert werden.

Substances Table (China)

Restriction on Hazardous Substances statement (Turkey)
Türkiye Cumhuriyeti: EEE Yönetmeliğine Uygundur
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Additional statements for wireless products
FCC compliance statement—United States

Exposure to radio frequency radiation

CAUTION: The radiated output power of this device is far below the FCC radio frequency exposure
limits. Nevertheless, the device shall be used in such a manner that the potential for human contact
during normal operation is minimized.

In order to avoid the possibility of exceeding the FCC radio frequency exposure limits, human proximity
to the antenna shall not be less than 20 cm ( (8 in)) during normal operation.

This device complies with Part 15 of FCC Rules. Operation is subject to the following two conditions:
(1) this device may not cause interference, and (2) this device must accept any interference, including
interference that may cause undesired operation of the device.

CAUTION: Based on Section 15.21 of the FCC rules, changes of modifications to the operation of this
product without the express approval by Hewlett-Packard Company may invalidate its authorized use.

Australia statement
This device incorporates a radio-transmitting (wireless) device. For protection against radio transmission
exposure, it is recommended that this device be operated no less than 20 cm from the head, neck, or
body.

Brazil ANATEL statement
Este equipamento opera em caráter secundário, isto é, não tem direito à proteção contra interferência
prejudicial, mesmo de estações do mesmo tipo, e não pode causar interferência a sistemas operando
em caráter primário.

Canadian statements
For Indoor Use. This digital apparatus does not exceed the Class B limits for radio noise emissions
from digital apparatus as set out in the radio interference regulations of the Canadian Department of
Communications. The internal wireless radio complies with RSS 210 of Industry Canada.

Pour l´usage d´intérieur. Le présent appareil numérique n´émet pas de bruits radioélectriques
dépassant les limites applicables aux appareils numériques de Classe B prescribes dans le règlement
sur le brouillage radioélectrique édicté par le Ministère des Communications du Canada. Le composant
RF interne est conforme à la norme CNR-210 d´Industrie Canada.

European Union regulatory notice
The telecommunications functionality of this product may be used in the following EU and EFTA
countries/regions:

Austria, Belgium, Bulgaria, Cyprus, Czech Republic, Denmark, Estonia, Finland, France, Germany,
Greece, Hungary, Iceland, Ireland, Italy, Latvia, Liechtenstein, Lithuania, Luxembourg, Malta,
Netherlands, Norway, Poland, Portugal, Romania, Slovak Republic, Slovenia, Spain, Sweden,
Switzerland, and United Kingdom.
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Notice for use in France
For 2.4 GHz Wireless LAN operation of this product certain restrictions apply: This equipment may be
used indoor for the entire 2400-2483.5 MHz frequency band (channels 1-13). For outdoor use, only
2400-2454 MHz frequency band (channels 1-9) may be used. For the latest requirements, see
www.arcep.fr.

L'utilisation de cet equipement (2.4 GHz Wireless LAN) est soumise à certaines restrictions : Cet
équipement peut être utilisé à l'intérieur d'un bâtiment en utilisant toutes les fréquences de 2400-2483.5
MHz (Chaine 1-13). Pour une utilisation en environnement extérieur, vous devez utiliser les fréquences
comprises entre 2400-2454 MHz (Chaine 1-9). Pour les dernières restrictions, voir, www.arcep.fr.

Notice for use in Russia
Существуют определенные ограничения по использованию беспроводных сетей (стандарта
802.11 b/g) с рабочей частотой 2,4 ГГц: Данное оборудование может использоваться внутри
помещений с использованием диапазона частот 2400-2483,5 МГц (каналы 1-13). При
использовании внутри помещений максимальная эффективная изотропно–излучаемая
мощность (ЭИИМ) должна составлять не более 100мВт.

Korean statement

Taiwan statement

ENWW Additional statements for wireless products 179
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A
accessories

ordering 151,  152
acoustic specifications 164
ad-hoc wireless network

configuring 40
description 39

alerts, setting up 89
anticounterfeit supplies 99
archive setting 15
automatic crossover, setting 16

B
batteries included 169
bin, output

jams, clearing 131
locating 4

Black in wrong position error
message 120

booklets
creating (Windows) 76

C
calibrating color 12,  91
Canadian DOC regulations 175
canceling

print job 54
cartridge-door release, locating 4
cartridges

non-HP 99
recycling 100,  167
replacing 101
status, viewing with HP Toolbox

FX 89
storage 99
supplies status page 10,  86
warranty 155

cartridges, print
Macintosh status 32

cautions iii

checklists, printing 11
cleaning

paper path 135
color

adjusting 80
calibrating 12,  91
Edge Control 81
halftone options 82
matching 83
Neutral Grays 82
printed vs. monitor 83
printing in grayscale

(Windows) 67
color alignment, calibrating 135
color options

HP EasyColor (Windows) 82
setting (Windows) 66

color settings
adjusting 133

Color tab settings 32
color usage log 10,  86
configuration page 10,  86
connecting to a wireless

network 36
connectivity

solving problems 141
USB 34

contrast
display, control panel 13
print density 91

control panel
display contrast 13
language 12
locating 4
menu map, printing 10,  86
message types 117
messages,

troubleshooting 117
Network config. menu 16

Reports menu 10
Service menu 15
System Setup menu 12

conventions, document iii
copies

changing number of
(Windows) 56

counterfeit supplies 99
Courier font settings 14
cover pages

printing (Mac) 30
printing on different paper

(Windows) 72
curl, paper

settings 15
custom print settings

(Windows) 56
custom-size paper settings

Macintosh 30
customer support

online 160
repacking product 161

Cyan in wrong position error
message 120

D
declaration of conformity 171
default settings, restoring 15
defaults, restoring 116
defects, repeating 138
demo page 10,  86
density settings 91
device error message 121
device status

Macintosh Services tab 32
DIMMs

installing 105
verifying installation 108

display contrast, setting 13
disposal, end-of-life 169
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document conventions iii
document feeder

locating 4
double-sided printing (duplexing)

Mac 31
downloading software

printing system 17
drivers

changing paper types and
sizes 45

changing settings (Mac) 27
changing settings

(Windows) 20
presets (Mac) 29
settings (Mac) 29
settings (Windows) 55
supported (Windows) 18
usage page 10,  86

duplex printing (double-sided)
settings (Windows) 61

E
e-mail alerts, setting up 89
Edge Control 81
electrical specifications 164
embedded Web server

Networking tab 96
Status tab 95
System tab 95

Embedded Web Server (EWS)
assigning passwords 97

end-of-life disposal 169
engine, cleaning 110
environmental features 3
environmental stewardship

program 167
error messages, control

panel 117
errors

software 147
European Union, waste

disposal 169
event log 89

F
factory defaults, restoring 15
factory settings, restoring 116
fan error message 119
fax

factory settings, restoring 116

Finnish laser safety
statement 176

firewall 36
first page

printing on different paper
(Windows) 72

use different paper 30
fonts

Courier settings 14
DIMMs, installing 105
lists, printing 10,  86
permanent resources 108

forms
printing (Windows) 67

fraud hotline 99
front door, locating 4
fuser

errors 118
jams, clearing 130

G
graph paper, printing 11
grayscale

printing (Windows) 67

H
help

printing options (Windows) 55
Help tab, HP ToolboxFX 89
HP Customer Care 160
HP Easy Color

disabling 82
using 82

HP Embedded Web Server
accessing 94

HP Embedded Web server 28
HP fraud hotline 99
HP Toolbox FX

Status tab 89
HP ToolboxFX

about 88
density settings 91
Help tab 89
Network Settings tab 93
opening 88
System Settings tab 89
System Setup tab 93

HP Utility 28
HP Utility, Mac 27
HP Web Jetadmin 97

HP-UX software 22

I
image quality

archive setting 15
HP ToolboxFX settings 91
solving 132

infrastructure wireless network
description 39

input tray
loading 48
locating 4

install supplies message 121
installing

product on wired networks 35
software, USB connections 34
software, wired networks 25,

36
interface ports

types included 5
invalid driver error message 121
IP address

obtaining 25,  35

J
jam-access door, locating 4
jams

causes of 125
locations 126
output bin, clearing 131
paper path, clearing 130
tracking number of 10,  86

jams <location>
error messages 121

jams tray #
error messages 121

Japanese VCCI statement 175
Jetadmin, HP Web 97

K
Korean EMC statement 176

L
labels

printing (Windows) 69
landscape orientation

selecting, Windows 64
language, control panel 12
laser safety statements 175,  176
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last page
printing on different paper

(Windows) 72
letterhead

printing (Windows) 67
license, software 157
link speed settings 41
Linux 22
Linux software 22
loading paper

error messages 122
input tray 48

M
Mac

changing paper types and
sizes 29

driver settings 27,  29
HP Utility 28
problems,

troubleshooting 148
removing software 27
supported operating

systems 24
Macintosh

resize documents 30
support 160

Macintosh driver settings
custom-size paper 30
Services tab 32
watermarks 30

Magenta in wrong position error
message 122

managing network 40
matching colors 83
material restrictions 169
Material Safety Data Sheet

(MSDS) 169
media

custom-size, Macintosh
settings 30

default settings 12
first page 30
pages per sheet 31

media jams. See jams
memory

error messages 122
included 2
installing 105

permanent resources 108
verifying installation 108

memory chip, print cartridge
description 156

menu
Quick Forms 11

menus, control panel
map, printing 10,  86
Network config. 16
Reports 10
Service 15
System Setup 12

mercury-free product 169
messages, control panel 117
misprint error message 123
multiple pages per sheet

printing (Windows) 63
music paper, printing 11

N
n-up printing

selecting (Windows) 63
network

disabling wireless 38
link speed settings 41
operating systems

supported 34
password, changing 41
password, setting 41
settings, changing 40
settings, viewing 40

Network config. menu 16
Network port

locating 5
type included 5

Network Settings tab, HP
ToolboxFX 93

Networking tab, embedded Web
server 96

networks
configuration page 10,  86
configuring 40
embedded Web server,

opening 94
HP Web Jetadmin 97
models supporting 2
settings 16
settings report 10,  86

networks, wired
installing product 35

Neutral Grays 82
non-HP supplies 99
notebook paper, printing 11
notes iii

O
obtaining

IP address 25,  35
on/off switch 5
online support 160
opening printer drivers

(Windows) 55
operating systems supported 18,

24
operating systems, supported for

networks 34
ordering

supplies and accessories 152
ordering supplies

Web sites 151
orientation

selecting, Windows 64
output bin

jams, clearing 131
locating 4

output quality
archive setting 15
HP ToolboxFX settings 91

P
packaging product 161
page count 10,  86
page sizes

scaling documents to fit
(Windows) 74

page too complex error
message 123

pages per minute 2
pages per sheet

selecting (Windows) 63
paper

covers, using different
paper 72

curl settings 15
custom-size, Macintosh

settings 30
default settings 12,  91
default size for tray 51
first and last pages, using

different paper 72
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first page 30
HP ToolboxFX settings 89,

92
jams 125
pages per sheet 31
printing on preprinted letterhead

or forms (Windows) 67
selecting 134
supported sizes 46

paper jams. See jams
paper path

jams, clearing 130
paper pickup problems

solving 125
paper size

changing 45
paper sizes

selecting 59
selecting custom 60

paper type
changing 132

paper types
changing 45
selecting 60

paper, ordering 152
paper, special

printing (Windows) 69
part numbers 152
PCL drivers 18
PCL font list 10,  86
PCL settings, HP ToolboxFX 93
permanent resources 108
physical specifications 164
portrait orientation

selecting, Windows 64
ports

types included 5
PostScript settings, HP

ToolboxFX 93
power

consumption 164
power connection, locating 5
power switch 5
preprinted paper

printing (Windows) 67
presets (Mac) 29
print cartridges

checking for damage 137
door release, locating 4
Macintosh status 32

memory chips 156
non-HP 99
recycling 100,  167
replacing 101
status, viewing with HP Toolbox

FX 89
storage 99
supplies status page 10,  86
warranty 155

print cartridges, accessing 4
print density settings 91
print job

canceling 54
changing settings 19

print media
supported 46

print quality
archive setting 15
HP ToolboxFX settings 91
improving 132
improving (Windows) 59

print quality page
interpreting 137
printing 137

printer driver
configuring wireless

network 38
printer drivers

choosing 138
printer drivers (Mac)

changing settings 27
settings 29

printer drivers (Windows)
changing settings 19,  20
settings 55
supported 18

printing
settings (Mac) 29
settings (Windows) 55

printing on both sides
settings (Windows) 61

printing system software 17
problem-solving

no response 140
slow response 140

product registration 93
PS Emulation drivers 18
PS font list 10,  86

Q
quality

archive setting 15
HP ToolboxFX settings 91

R
rear door, locating 5
recycling

HP printing supplies returns and
environmental program 168

recycling supplies 100
registration, product 93
removing Mac software 27
repacking product 161
repeating defects,

troubleshooting 138
repetetive defects,

troubleshooting 138
replacement parts, and

supplies 152
replacing print cartridges 101
Reports menu 10
resize documents

Macintosh 30
Windows 74

resource saving 108
restoring default settings 15
restoring factory settings

defaults 116

S
safety statements 175,  176
saving resources, memory 108
scale documents

Macintosh 30
Windows 74

service
repacking product 161

service error message 119
Service menu 15
service page 10,  86
Services tab

Macintosh 32
settings

driver presets (Mac) 29
drivers 20
drivers (Mac) 27
factory settings, restoring 116
HP ToolboxFX 89
network report 10,  86
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restoring defaults 15
System Setup menu 12

shipping lock error
message 123

shipping product 161
shortcuts (Windows)

creating 57
using 56

size specifications, product 164
sizes, media

default, setting 12
sleep delay

disabling 98
enabling 98

software
embedded Web server 28
HP ToolboxFX 88
HP Utility 28
installing, USB

connections 34
installing, wired networks 25,

36
Linux 22
problems 147
software license

agreement 157
Solaris 22
supported operating

systems 18,  24
uninstalling for Windows 21
uninstalling Mac 27
UNIX 22
Web sites 17
Windows 22

Solaris software 22
solving

direct-connect problems 141
network problems 141

spare parts 152
special media

guidelines 44
special paper

guidelines 44
printing (Windows) 69

specifications
electrical and acoustic 164
physical 164

status
alerts, HP Toolbox FX 89
HP Utility, Mac 28

Macintosh services tab 32
supplies, printing report 10,

86
viewing with HP Toolbox

FX 89
Status tab, embedded Web

server 95
Status tab, HP Toolbox FX 89
storing

print cartridges 99
supplies

counterfeit 99
non-HP 99
ordering 93,  151,  152
recycling 100,  167
shipping lock error

message 123
status, viewing with HP Toolbox

FX 89
status, viewing with HP

Utility 28
wrong position error

message 120,  122,  124
supplies status page

printing 136
supply-status, Services tab

Macintosh 32
support

online 93,  160
repacking product 161

supported paper 46
System Settings tab, HP

ToolboxFX 89
System Setup menu 12
System Setup tab, HP

ToolboxFX 93
System tab, embedded Web

server 95

T
TCP/IP

operating systems
supported 34

settings 16
technical support

online 160
repacking product 161

tips iii
toner cartridges. See print

cartridges

ToolboxFX,HP 88
transparencies

printing (Windows) 69
trapping 81
tray

capacities 47
paper types supported 47
paper weights 47

Tray 1
double-sided printing 31
jams, clearing 127
locating 4
settings 12

Tray 2
capacity 4
jams, clearing 129
locating 4
settings 12

trays
default paper size 51
double-sided printing 31
included 2
jams, clearing 129
load error messages 122
locating 4
selecting (Windows) 60
settings 12,  91

troubleshooting
control panel messages 117
direct-connect problems 141
jams 125,  126
Mac problems 148
network problems 141
repeating defects 138

two-sided printing
settings (Windows) 61

types, paper
HP ToolboxFX settings 92

U
uninstalling Mac software 27
uninstalling Windows software 21
UNIX 22
UNIX software 22
usage page 10,  86
USB

configuring wireless
network 26,  37

USB cable, part number 152
USB configuration 34
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USB port
locating 5
speed settings 15
type included 5

W
warnings iii
warranty

license 157
print cartridges 155
product 154

watermarks
adding (Windows) 76

Web sites
customer support 160
fraud reports 99
HP Web Jetadmin,

downloading 97
Macintosh customer

support 160
Material Safety Data Sheet

(MSDS) 169
ordering supplies 151
software, downloading 17

Windows
driver settings 20
drivers supported 18
software components 22
supported operating

systems 18
wireless

disabling 38
wireless network

ad-hoc 39
communication modes 39
configuring ad-hoc 40
configuring with USB 26,  37
configuring with WPS 26,

37
infrastructure 39
installing the driver 38
security 39

wireless network connection 36
wireless network interference 38
WPS

configuring wireless
network 26,  37

Y
Yellow in wrong position error

message 124
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